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1. Welcome 

 

Welcome to a long-lasting co-operation with Esko. 

 

The intention of this User Manual is to provide information sufficient to: 

 Understand the main principles of the XP system. 

 Learn how to operate the XP table in order to produce the expected result. 

 Learn about the XP safety rules in order to operate the system in a safe way. 

 

 

The manual is divided into the following main sections: 

 

 Safety regulations The main safety issues are described. 

 System description A short-form description of the system. This section is divided into two 

chapters: 

 System description. 

 Graphical User Interface (GUI). This part is available as context 

sensitive help from the XP-Guide program. In addition, it is 

available as Appendix A in this manual. 

 How to‟s.. Typical tasks are described in detail. 

 Preparing for a job What do I have to prepare before the start of a job. This is a part of 

the „How to‟ chapter. 

 Work with ARS The Automatic Registration System is covered by a separate chapter. 

 System setup A description of all parameters to be set and how to set them. 

 Tooling system A complete description of the XP tooling system. 

 Maintenance What maintenance is required in a short and long term. 

 Appendices  

 

 

Some definitions used in this document: 

 

Name or style Description 

Pop-up dialog  
This is the dialog that appears when you click the Right mouse 
button. 

Start button The italic style indicates this is a button on the Operator panel. 

OK 
The bold style indicates this is a button or function in the XP-Guide 
user interface. 

Options->System Option Menu selection: From the Options menu, select System Option 

(123) 
123 is the page number where the actual function is described. It is 

also a hyperlink; a mouse-click on the number will bring you directly 
to the issue. 
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1.1 Local languages 

This manual is available in a wide range of local languages. When the document is translated into a 

local language, the screen pictures, some illustrations and the content in the Appendices remains in 

English language. 

 

 

1.2 About XP-Guide dialogs 

 

To exit from any XP-Guide dialog, use the 

control buttons available. 

Using the cross in upper right corner is not 

recommended and the consequence is un-

predictable. 
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2. Safety regulations 

 

2.1 Introduction 

The Kongsberg table is designed to conform to safety regulation standards. 

Nevertheless, operating the table can involve hazards if the operator does not follow the operating 

instructions or uses the table for non-intended purposes. 

The safety regulations described below are supplemented with safety warnings in the respective 

topics. 

 

2.2 Responsibilities 

2.2.1 The manufacturer 

The manufacturer is responsible for delivering the system according to safety regulation standards. 

 

2.2.2 The customer 

The customer is responsible for: 

 Ensuring that the system is used for it's intended use only 

 Allowing that only authorized and trained personnel operate the system 

 Preventive maintenance as described in the Maintenance manual. 

 The local regulations regarding installation and operation are fulfilled. 

 

2.2.3 The operators 

The operators are responsible for: 

 Operating the system only when it is in a flawless state. 

 Ensuring that no unauthorized persons come close to the system. 

 

2.3 Requirements to be met by operators 

The personnel operating the system must: 

 Be adequately trained. 

 Have read and understood the instructions described in "Safety regulation" as well as any 

other safety warnings. 

 

2.4 Definition of use 

The intended use is described in the „How to..‟ chapter. Any other use is considered non-intended 

use. 

 

Examples of non-intended use: 

 Operation by operators not meeting the requirements as described above. 

 Unauthorized modifications (bridging safety devices, removing covers etc.) 

 Utilizing accessories other than those specified by Esko. 

../Documents%20and%20Settings/jhbe/Application%20Data/Microsoft/Word/Maintenance.htm
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Non-intended use may cause: 

 Health hazards and injuries. 

 Damage to the system. 

 Incorrect functionality. 

 Damage to work materials. 

 

Esko is not liable for any damage resulting from such non-intended use.  
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2.5 Danger zones   

2.5.1 Moving parts, laser radiation and high voltage 

 

Y

X

 
 

The area around the moving parts should be considered to be a danger zone. 

 

2.5.2 Noise level 

Y

X

 
 

Hearing protection should be used by any personnel exposed to the noise from the XP table. 
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2.5.3 Ejection of parts 

  

 
 

Potential risk when running the HSMU/HPMU: 

 

Personnel hit by breaking milling bit or small 
pieces of processed material. 

 

Eye protection should be used by any personnel 

working with HSMU/HPMU on XP. 

 

 

 

 

 

 

 

2.6 Warning sign explanation 

 

Knife blades are extremely sharp. 

Used in this documentation to indicate operations with knife 
blades and milling bits. 

 

Potential areas with a risk of being squeezed are marked with 
the 'do not touch' sign. These areas are: 

 Between Y carriage and rack 

 When the Y carriage moves towards traverse ends. 

 Between the table top and the moving traverse. 

 Underneath the tool head. 

 

The Hearing Protection symbol indicates areas where the use of 
hearing protection is compulsory. 
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The Eye Protection symbol indicates areas where the use of eye 
protection is compulsory. 

Moving parts

 

Potential areas with a risk of being hit by moving parts are 
marked with the 'Moving Parts' sign. These areas are: 

 Both traverse ends. 

 Y carriage. 

 Tool head(s). 

Do not remove cover before 
mains is disconnected

High voltage controlled from 
external source inside

WARNING

 

The main power unit contains main voltage and may only be 

opened by authorized personnel. The main power unit is 
marked with the 'voltage' warning sign. 

CAUTION
LASER RADIATION

DO NOT STARE INTO BEAM

AVOID EXPOSURE
Laser radiation emitted from this aperture

DIODE LASER
MAX OUTPUT 1 mW

WAVELENGTH 650-660nm
EN 60825-1: 1994+A11:1996

CLASS II LASER PRODUCT

 

Laser radiation. The tool head is equipped with a class II laser 

pointer. 

Avoid laser light into your eyes. 
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2.7 Safety devices 

  

2.7.1 Overview 

 

1

4

3

2

5

Y

X

   

  

1 The Main power switch 

2 Emergency stop  

3 Yellow / black tape on the floor to indicate attention area 

4  Warning lamp 

5 Dynaguard 

 

2.7.2 The Main power switch 

 

The Main power switch turns power to the table on/off. 
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2.7.3 Emergency stop button 

 

When hit, the Emergency stop button switches off all power to the table. 

 

Note: Activating the emergency stop button does not provide a guarantee 

against injury!  

Due to the high kinetic energy of moving parts do not underestimate 
stopping distances of traverse, Y carriage and tool head. 

 

 

2.7.4 Yellow / black tape 

The yellow / black tape indicates the warning area. This area is restricted to operators and other 

trained personnel. 

 

 

2.7.5 Warning lamp on top of Y carriage 

Light is Description 

Off Servo power is off 

On Servo power is on, Safety system is enabled, table is in operation 

Blinking Safety system is activated. Reset Safety system to continue operation 

 

2.7.6 DynaGuard Safety System 

The Photocell safety system consists of two light beams in front of the traverse and two behind. In 

addition, there is a stop mechanism mounted on each end of the traverse. 

Machine movement will stop and servo power will be switched off if: 

 One of the light beams is broken. 
 The stop mechanism is activated, for instance when a person is standing too near the table. 

To continue operation after the Safety system has been activated, do: 

 Reset the Safety system by pressing Stop on Operators panel 
 Press Start to continue operation 
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2.8 Protective equipment 

For the operator(s), Esko recommends the following protective equipment: 

 

 

 Close-fitting clothes to avoid being caught by the beam or the tool head 
which can cause injuries. 

 

 Gloves to protect against cuts from materials with sharp edges 

 

 Eye protection should be used by any personnel working with 
HSMU/HPMU on XP. 

 

 

 Always use hearing protection when working with the machine for a 

longer period of time. 

The acoustic noise level will vary with the type of operation and tooling, 

but a typical average level is 78.5 – 83.5 dBA and a maximum level of 
98.5 dBA.  

  

 

 

2.9 Procedures in case of malfunctions 

Trouble-shooting and repair shall only be executed by authorized personnel. 

Contact the Esko Service Organization. 

 

 



User Manual, Kongsberg XP 

 

 16 

3. System description 

 

3.1 Application programs available 

  

After installation of XP-Guide, the following application programs are available: 

 

XP-Guide Control program for the XP - table 

SysLoad Program for download of updates to CU – modules. 

HWT900XP Hardware test program, see separate HWT900XP User Manual. 

FaceMill A program for face milling. Prepared for HSMU/HPMU (145). 

FaceCut A program for simple cut out of squares. Prepared for knife or milling (145). 
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3.2 Naming conventions 

 

3.2.1 Table 

 
 

 

1 Cutting table 

2 Traverse 

3 Y carriage 

4 Tools 

5 Main Power Unit (MPU) 

6 Emergency stop button 

7 Operator panel 

8 Main power on/off switch 

9 Traverse safety stop switches 

 

 

3.2.2 Axes 

 

X1

Y

X2Z1 Z2
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3.2.3 The Graphical User Interface 

 
 

The XP Graphical User Interface (GUI) contains these main elements: 

 

1 Main Menu 5 Preview 

2 Main Toolbar 6 Job View Toolbar 

3 File View Toolbar 7 Job View  

4 File View 8 ARS Toolbar 

 9 Status Bar 
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3.3 Operating elements 

 

The table is equipped with the following operating elements: 

 

 Main power switch 

  

 Emergency stop switch 

 

 Operators Panel 

  

3.3.1 Main power switch 

On XP, the Main power switch is located on the Front Panel or Revolving Work Station. 

 

 

Switch positions: 

 

0 - the main power to the machine is switched OFF. 

 

I - the main power to the machine is switched ON. 

 

 

  

3.3.2 Emergency stop switch 

On XP, the Emergency stop switch is located on the Front Panel or Revolving Work Station. 

 

 

Switch positions: 

 

UP - the main power to the machine is switched ON. 

 

DOWN - the main power to the machine is switched OFF. 
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3.4 Operators panel 

 

 

 
 

3.4.1 Power on 

 

Lit when Main power is on 

 

3.4.2 Start button 

 

Press this button to start operation. 

 

3.4.3 Stop button 

 

Press this button to stop operation. 
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3.4.4 Vacuum On/Off button 

 

Press this button to switch Vacuum On/Off. 

 

3.4.5 Init Button 

 

Press this button to: 

 Initialize the system, i.e. give variables pre-set values. 
 Set Panel Reference Point. 

If Fixed Reference Point is disabled, the current position of the Laser Pointer is 
set as the new Reference Point. 

 

3.4.6 Table Zero / Forced tool height measure 

 

Press this button, then the Start button, to move the tool head to Zero 

Reference Point, which corresponds to origin in the Coordinate System. The 

Table Zero Mode is automatically selected at Start-Up. The button remains lit 

until the Zero Position is reached.  

 

If Forced tool height measuring mode is enabled, this button will start a Tool 
height measuring sequence. For more information, see (38). 

 

3.4.7 Servo On/Off 

 

Press this button to switch the Servo on/off. The servo power is on when the 

lamp is lit. 

 

3.4.8 Jog buttons 

 

Press the Jog buttons to move the tool head in the desired direction.  

The system must be in Stop mode, i.e. the Stop button must be lit, for 

these buttons to be operative. 

Note: It is possible to configure the jog direction, see Option, System 
setup. 
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3.4.9 Continuous Jog 

 

Press a Jog button to manually move the tool head with constant speed. 

The X and Y Jog buttons can be operated both individually and simultaneously. 

  

Press the single arrow for low jog speed. 

Press both symbols for medium jog speed. 

 

3.4.10 Incremental Jog / Forced tool height measure 

 

Press this button to select the Incremental jog / Forced tool height 
measuring mode. 

Press the button a second time to disable the Incremental jog / Forced tool 

height measuring mode. 

For information about Forced tool height measure, see (38). 

 

Press the two arrows to move the tool head a large step. 

Press the single arrow to move the tool head a small step. 

  

The size of the incremental movement can be changed from Option-> System 

setup. 

 

3.4.11 Tool Down 

 

Press this Tool Down button to manually operate the machine with a tool in the 

down position. 

Cancel by pressing Tool Down a second time. 

 

3.4.12 Vacuum release mode 

 

For details about this function, see separate chapter 'Vacuum control' (100). 
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3.4.13 Manual belt clamp 

 

In order to manually drag material onto the cutting table using the conveyor 

belt, the Manual Belt clamp function is available. 

 

The Manual Belt Clamp function is enabled after the Vacuum release button has 

been kept down for more than 2 secs. 

 

The Manual Belt Clamp function is active as long as the Vacuum release button is 

kept down. 

As long as the Manual Belt Clamp function is active, the following actions are 

carried out: 

 The belt clamps are activated. 

 The feeder paws are activated. 

 The operator panel jog buttons are available for manual movement of the 

traverse / conveyor belt. All other possible actions on the machine are 
inhibited. 

 Acceleration is reduced during belt movement. 
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3.5 High pressure air system 

3.5.1 General  

The High Pressure Air System supplies the valves and tooling with compressed air. 

 

 
 

For details regarding air supply requirements, see 'Site Preparation manual'. 

 

 

3.5.2 Air regulator settings 

Air

regulator

  

 

The compressed air is connected to a combined pressure regulator valve/water trap. 

The air pressure should be adjusted to minimum 6 bar (6 kg/cm2, 6*105 Pa). Recommended 

pressure level is 7 bar (7 kg/cm2, 7*105 Pa). 
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4. How to procedures 

4.1 Introduction 

 

Keep away from moving parts during operation. 

  

Do not lean on racks, guide ways or traverse during operation as this may cause personal 

injury. 

Before starting operation, make sure that: 

the table is free from obstructions 

no unauthorized personnel come close to the table 

 

All procedures for how to run the machine, except „Power on‟ is based upon the following 

assumptions: 

 The user interface is up and running. 
 The actual tools are properly mounted and adjusted. 

 

4.2 Power on sequence 

Follow these steps to power up the system and get ready to work: 

 

4.2.1 Front End PC 

Switch on the PC and the monitor. 

 

4.2.2 Table Power 

Switch the table on using the Main Power switch. 

Note: After power off, wait minimum 5 sec. before the system is switched on again. 

 

4.2.3 XP-Guide 

Use the mouse, double-click the icon for XP-Guide. Check that no error message indicates faulty 

conditions. 

 

4.2.4 Safety system 

Reset the Safety system by pressing the Stop pushbutton. 

 

4.2.5 Servo Power 

Press the Servo on pushbutton. The Warning lamp on top of the Y carriage should be on without 

flashing. 
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4.2.6 Table zero sequence 

Press Start pushbutton to complete the table zero sequence. The machine will move to current 

selected reference point. 

 

The table is now ready for operation. 

 

 

4.3 Continue after safety break 

If the Safety system is activated, all movements on the table are stopped and the Warning lamp on 

top of the Y carriage starts flashing. 

To continue operation, proceed as follows: 

1. Ensure the table is free from obstructions and ready for operation. 

2. Reset the Safety system by pressing the Stop pushbutton. 

 

 

4.4 Power Off sequence 

When power off, follow this sequence: 

 

4.4.1.1 Servo power off 

Press the Servo on pushbutton to switch servo power off. 

 

4.4.1.2 Table Power 

Switch Table power off using the Main Power switch. 

 

4.4.1.3 Front End PC 

To switch off the PC, use the Operating system shutdown procedure.  
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4.5 Preparing for a job 

 

Keep away from moving parts during operation. 

  

Do not lean on racks, guide ways or traverse during operation as this may cause 

personal injury. 

Before starting operation, make sure that: 

 the table is free from obstructions 

 no personnel come close to the table 

 

Use this chapter as a check – list when changing from one job to another. 

 

 

4.5.1 Job Setup 

 

Job Setup is a table that links 

Logical tool numbers (P - numbers) 

in the Input File to physical tools on 

the machine and describes their 

behavior (78). 

 

The Job Setup information is stored 

as a file on the front end PC. 

 

Select Job Setup file from the Job 
Setup drop down list. 

 

 

4.5.2 Board Setup 

 

Position the material for the job on the 

table.  

Select Board Size from the Board Size 

drop down list. 

 

Note: Board size information is used for 

calculating Step & Repeat. If Step & 
Repeat is not used, this setup is optional. 
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4.5.3 Open an input file 

From File View, open files in one of following ways: 

 

 Double click on a file. 

 
Select a file and click the Open button. 

 
Click on a file, hold the left mouse button down, drag the file into Job View and release 
it. 

 
When Auto Open is enabled and activated the files will be opened automatically.  

 

 

 

4.5.4 Set flute direction 

 

Use the Toggle Flute Direction button to set 
correct direction for the actual job. 

 

 

4.5.5 Vacuum Section Setup 

 

From the Vacuum Section setup – dialog, 
configure a suitable vacuum area for the job. 

 

 

 

4.5.6 Select proper speed  

The machine speed during execution will have important impact on the final result.  

For some combinations of tools and materials, you can run with full speed, for other combinations, 

the speed and/or the acceleration has to be reduced. 

For this purpose, the following alternatives are available: 

 Select between High Quality, Normal or High Speed mode (75). 

 Reduce the overall acceleration (69). 

 Reduce the speed and acceleration for the Job setup line (80) 
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4.5.7 Run the job 

 Verify that the display of the job in Job View is reasonable. 

 

Ensure that all settings are proper. 

 

Press Vacuum on to start the vacuum pump (If you are running with Automatic vacuum control 

enabled, the pump will start automatically when Start is pressed). 

 

Press Start to execute the job. 

 

 

 

4.6 Open an Input File 

 

From File View, open Input Files in one of following ways: 

 

 Double click on a file. 

 
Select a file and click the Open button. 

 
Click on a file, hold the left mouse button down, drag the file into Job View and release 
it. 

 
When Auto Open is enabled and activated the files will be opened automatically (183).  

 

 

The formats available are:  

 

File 

extension 
Description 

.acm 
Kongsberg acm – format. This is the default input format for Kongsberg XP. Described 
in the Technical Reference manual for XP. 

.plt HPGL. Described in the Technical Reference manual for XP. 

.dxf DXF. See Appendix about DXF input tuning (193). 

.ard ArtiosCAD. See Appendix about the ArtiosCAD module CAD-X (193). 

.cf2 CF2. See Appendix about the ArtiosCAD module CAD-X (193). 

.ddes DDES. See Appendix about the ArtiosCAD module CAD-X (193). 

 

The format is selected from the System Setup dialog (74).  

Standard file extensions will be automatically recognized. 
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4.7 Corrugated Production 

 

Take care: 

 Knife blades are extremely sharp. 

 Keep away from all moving parts. 

 Ensure all other personnel stays in a safe distance from all moving parts. 

 Use hearing protectors. 

 

1. Ensure that the tool configuration is correct for the job and corresponds with the Job Setup 

information. 

2. Ensure that the knife blade is sharp and proper.  

3. Ensure that the Job Setup information is correct for the material. If not, select Job Setup 

file. 

4. From File View, select the Input File. 

5. Retrieve information about required sheet size from Job View. 

6. Position a sheet of material against the left ruler. Retrieve information about the flute 

direction from the Job View window and position the material accordingly. 

7. Configure vacuum zones according to the material size. 

8. Switch Vacuum on. 

9. Ensure that you run with a suitable Program Reference point. 

10. Execute the job by pressing Start. 
11. To repeat the job, press Init and repeat this procedure from point 5. 

 

4.8 Milling Production 

 

Take care: 

Milling bits are extremely sharp. 

Keep away from all moving parts. 

Ensure all other personnel stays in a safe distance from all moving parts. 

Use hearing protectors. 

 

Milling jobs should be executed in High Quality mode (75).  

1. Ensure that the tool configuration is correct for the job and corresponds with the Job Setup 

information. 

2. Ensure that the router bit is sharp and proper for the job. 

3. Ensure that the Job Setup information is correct for the material. If not, select Job Setup 

file. 

4. From File View, select the Input File. 

5. Retrieve information about required sheet size from Job View. 

6. Position a sheet of material against the left ruler.  

7. Configure vacuum zones according to the material size. 

8. Switch Vacuum on. 

9. Ensure that you run with a suitable Program Reference point. 

10. Execute the job by pressing Start. 
11. To repeat the job, press Init and repeat this procedure from point 6. 
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4.9 Hard board production 

 

Take care: 

 Milling bits are extremely sharp. 

 Keep away from all moving parts. 

 Ensure all other personnel stays in a safe distance from all moving parts. 

 Use hearing protectors. 

 

 

To prepare hard board materials, the procedure 
is as follows: 

1. Mill through the top layer using 

HSMU/HPMU. 

 

2. Cut through the mid-section using the 

HF VibraCut knife tool. 

 

3. Mill through the bottom layer using 
HSMU/HPMU. 

 

1. Ensure that the tool configuration is correct for the job and corresponds with the Job Setup 

information. 

2. Ensure that the router bit is sharp and proper for the job. 

3. Ensure that the knife blade is sharp and proper for the job. 

4. Ensure that the Job Setup information is correct for the material. If not, select Job Setup 

file. 

5. From File View, select the Input File. 

6. Retrieve information about required sheet size from Job View. 

7. Position a sheet of material against the left ruler.  

8. Configure vacuum zones according to the material size. 

9. Switch Vacuum on. 

10. Ensure that you run with a suitable Program Reference point. 

11. Execute the job by pressing Start. 

12. To repeat the job, press Init and repeat this procedure from point 6. 



User Manual, Kongsberg XP 

 

 32 

 

4.10 Cutting thick materials 

 

Take care: 

 Keep away from all moving parts. 

 Ensure all other personnel stays in a safe distance from all moving parts. 

 Use hearing protectors. 

 

When preparing materials with thickness between 45 – 50 mm (1¾ - 2 in.), the following rules 

apply: 

 

 No camera operations are available. 

 Disable Measure material thickness. 

 In Job setup, use T-function to specify the cutting depth. 

 This function is for knife tools only. 

 

  
Disable Material thickness measurement: 

Job setup->More 

 

Cutting depth using T-function: 

T-20
T0

 
 

Note: This function is useful for all materials with an un-even surface. 

 

4.11 Make a pen plot 

 

Take care: 

 Keep away from all moving parts. 

 Ensure all other personnel stays in a safe distance from all moving parts. 

 Use hearing protectors. 

 

1. Ensure that the tool configuration is correct for the job and corresponds with the Job Setup 

information. 

2. Ensure that the Ball point pen is proper for the job. 

3. Ensure that the Job Setup information is correct for the material. If not, select Job Setup 

file. 

4. From File View, select the Input File. 

5. Retrieve information about required sheet size from Job View. 

6. Position a sheet of material against the left ruler.  
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7. Configure vacuum zones according to the material size. 

8. Switch Vacuum on. 

9. Ensure that you run with a suitable Program Reference point. 

10. Execute the job by pressing Start. 
11. To repeat the job, press Init and repeat this procedure from point 6. 

  

4.12 Set the table up for multi pass creasing or milling 

 

Take care: 

 Knife blades are extremely sharp. 

 Keep away from all moving parts. 

 Ensure all other personnel stays in a safe distance from all moving parts. 

 Use hearing protectors. 

 

Multi pass creasing is beneficial if you want a deeper crease pattern. This is achieved by running one 

pass with for example 50% depth and a second pass with 70% dept. 

 

Multi pass milling is beneficial if you want to mill through a material where the thickness is bigger 

than the router bit diameter. 

 

Multi pass creasing or milling is available by modifications in the Job Setup file. Proceed as follows: 

1. Open the Job Setup file for editing. 

2. Identify the crease or milling line where multi pass is wanted. 

3. Add one or more new lines with the same logical tool number and specify the same tool and 

desired depth. 

4. When executing the job with this Job Setup file selected, the multi pass function will be 

carried out for the specified logical tool(s). 

5. The multi pass lines will be executed in the same sequence as they appear in the Job setup 
dialog. 

This picture shows a Job Setup with double pass creasing with logical tool no 22: 
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4.13 Jobs including reverse score 

 

Take care: 

 Knife blades are extremely sharp. 

 Keep away from all moving parts. 

 Ensure all other personnel stays in a safe distance from all moving parts. 

 Use hearing protectors. 

 

A typical use of reverse score is when you want to add a crease line on the front side of a 
material that you normally prepare from the rear side. 

Reverse score is available by modifications in the Job Setup file. This function requires that the 
table is equipped with left and right rulers. Proceed as follows: 

1. Open the Job Setup file for editing. 

2. Identify line for reverse score or add a line for this function. 

3. Open the More dialog for this line, enable Reverse score. 

4. When executing the job with this Job Setup selected, the Reverse score function will be 

carried out for the specified logical tool(s). 
5. Follow the instructions displayed when executing the job. 

The picture shows a Job Setup with reverse creasing using logical tool no 1: 

 

 
 

4.14 Work with different reference point settings 

To define or modify reference point settings, go to the Set Reference point wizard (72). 

Reference points are selected from the Job View Toolbar (185). 

 

 

../Documents%20and%20Settings/jhbe/Application%20Data/Microsoft/Word/Job_Setup.htm
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4.15  Work with Sequencing and Optimization 

4.15.1 Sequencing disabled 

P2, knife

P2, knifeP2, knifeP2, knife

P2, knife

P2, knife

P1, crease

P1, creaseP1, creaseP1, crease

Input file

Execution

P1, crease

P1, crease

 
 

The input file is executed as is. 

 

4.15.2 Sequencing enabled 

P2, knife

P2, knifeP2, knifeP2, knife

P2, knife

P2, knife

P1, crease

P1, creaseP1, creaseP1, crease

Input file

Execution

P1, crease

P1, crease

 
 

All crease lines are executed before knife cuts. The sequence is: pen, crease, v-notch knife, milling, 

knife, drill. 

 

4.15.3 Sequencing and knife before crease enabled  

P2, knife

P2, knifeP2, knifeP2, knife

P2, knife

P2, knife

P1, crease

P1, creaseP1, creaseP1, crease

Input file

Execution

P1, crease

P1, crease

 
 

All knife cuts are executed before crease lines. The sequence is: pen, milling, knife, crease, 

V-notch knife, drill. 
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4.16 Work with Register bar 

The Register bar is an aid when the material needs registrations that fits the requirements of a 

specific printing press or die cutter. 

 

  

 

On XP, the register bar is mounted along the X - 

axis as illustrated at left.  

Register bar - Register bar fixed to the table. 

Material - Sheet of material with pre-punched holes 

that fit the Positioning pins on the Register bar. 

Positioning pins. Use these pins to fix the sheet of 

material in a correct position on the table. When 

the sheet is fixed and vacuum is switched on, you 

must remove the pins. 

Cutting underlay - Cutting underlay. 

Area not available for tools - This area is outside 

the working area of the machine. 

 

4.16.1 Work flow 

 

Take care: 

 Knife blades are extremely sharp. 

 Keep away from all moving parts. 

 Ensure all other personnel stays in a safe distance from all moving parts. 

 Use hearing protectors. 

 

  

 

Place the sheet of material onto the cutting table 

and align the holes in the material with the 
positioning pin holes. 

Insert the positioning pins. 

 

When both positioning pins are in place, the sheet is 
correctly positioned. 
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Switch vacuum on. 

 

IMPORTANT: Remove the Positioning pins. 

Now, the machine is ready for operation. 

 

4.16.2 Reference point setting 

  

When working with register bar, select one of the 

available Reference points ( Option->Table options ) 

and set a reference point in a fixed position relative 

to one of the Positioning pins  

(R in the illustration). 

This position should be used as origin during 
geometry design and cam file generation. 

 

 

When preparing the job in the CAD - system, use 
the same Reference point as origin. 

 

 

This work flow ensures exact positioning of the 

geometry relative to the Positioning pins. 
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4.16.3 Forced tool height measurement 

 

Follow these steps to start a tool height measuring sequence: 

 

 

1) Enable Incremental Jog. 

 

2) Select the Table Zero sequence. 

 

 

3) Press Start to execute the height measuring sequence (as part of the Table 

zero sequence). 
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5.Work with ARS 

 

5.1 Introduction 

XP offers different levels of automation for Registration mark reading: 

 

ARS 

1 - Manual reading of 2 registration marks by use of laser pointer (standard). 

2 - Manual reading of 2 registration marks by use of camera as pointing device (option). 

3 - Automatic reading of up to 4 registration marks. Linear transformation (option). 

   

 

This chapter will cover all ARS – related issues. 

 

The camera solution used in ARS is based upon a Scorpion software package.  

 

Thus, it is a pre-requisite that Scorpion is properly installed and configured together with XP-Guide 

in order to make ARS work. 

 

Note: The Job layout function is not available when running ARS. 
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5.2 ARS - modes of operation 

 

5.2.1 Introduction 

All settings described in this chapter are available from the Registration setup dialog, available from: 

 

 XP-Guide->Option->Registration setup 

 

Job view toolbar -> Enter ARS registration setup dialog 

The button change face depending upon if ARS is running or not. 

XP-Guide is running with ARS enabled. 

 

Job view toolbar -> Enter ARS registration setup dialog  

No ARS functions are enabled. 

 

 
 

 

 
 

 
The mode of operation is specified by 3 (4) parameters as illustrated above: 

 Register mark input / position input 

 Work flow 

 Transformation 

 Registering tool 

 Camera operations 
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5.2.2 Registering tool 

 

From the drop down menu, select the tool to use for registration 

or No registration. 

 

 

 

5.2.3 Register mark input 

Specify how the location of the register marks is specified to the system: 

 

5.2.3.1 From input file 

The location of the register marks is specified in the input file, provided by the CAD – system. 

 

5.2.3.2 Manual 

The location of the register marks is entered manually. 

 

5.2.3.3 Register mark position 

Press the Register mark position button to enter the dialog: 

 

 

 
 

If your Register mark input is from input file, 

enter A/B values. 

 

If your Register mark input is Manual, enter 

A/B/C/D values. 
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5.2.4 Camera operation 

Use this setting to select between a manual or automatic mode of operation: 

 

5.2.4.1 Manual detection of register marks 

Pointing with laser 

A wizard will guide you from one register mark to the next. 

Place the laser pointer in the center of the register mark and press Start. 

 

 

Viewing with camera 

This is a manual, visual detection of register marks. 

A wizard will guide you from one register mark to the next. 

Place the camera (cross in the view) in the center of the register mark and press Start. 

 

 

5.2.4.2 Automatic detection of register marks 

Automatic detection 

The system will, by means of a camera picture, automatically detect the position of the register 

mark. 

 

 

Circle or cross as register mark 

Specify if the register mark is a cross or a circle. 

The geometry requirements are: 

 

T

L

 

2 mm < L < 12 mm 

1 mm < T < 0.5 * L 

 

0.08 in. < L < 0.47 in. 

0.04 in. < T < 0.5 * L 

R

 

 

2 mm < R < 12 mm 

 

0.08 in. < R < 0.47 in. 

 

 

 

 

Search 

If no register mark is detected inside the camera picture, the system will try to search for a register 

mark around the expected location (twice the size of the camera picture). 
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5.2.5 Workflow 

5.2.5.1 Register on – First sheet only 

Reading register marks will be carried out on the first sheet in a job. For the subsequent sheets, no 

register mark reading will take place.  

The compensations calculated for the first sheet will be used for all sheets in the job, that is, until a 

new file is opened. 

 

5.2.5.2 Register on – All sheets 

Reading register marks will be carried out for every sheet of material in a job. 

 

5.2.5.3 Continue with last found register mark set 

If, for any reason, reading register marks fails, the job will continue, using the last register mark 

information available. 

 

5.2.6 Transformation 

5.2.6.1 Offset and rotation only 

 

The design is offset and rotated. No scaling is applied. To calculate 

rotation minimum two marks are required. 

 

 

5.2.6.2 Common X/Y scale (Uniform) 

 

In addition to offset and rotation, the system will calculate a scale 

factor.  

Both axes are scaled with the same factor. 

 

 

5.2.6.3 Different X/Y scale (non-uniform) 

 

With this option, offset, rotation and scale is calculated, allowing 

different scale factors for the main design axes. Minimum three register 

marks are required. 
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5.3 Work with ARS (Automatic Registration System) 

 

5.3.1 The camera window 

This window is available from: 

 Registration setup->Camera setup 

 It pops up each time a register mark is searched for / detected. 

 

  
 

5.3.2 Camera control 

Three different camera control views are available from the tabs on top of window: 

Image  

This is the default view where the camera picture is shown. In the picture there 

is a red marker to indicate the centre of the picture.  

The green circle indicates that high accuracy area. If a register mark is detected 

outside this area the machine moves the camera centre over the register mark and 
takes a second picture.  

Camera  

This tab defines which camera to be used and also which camera that creates the 

Image. 

The only time the operator needs to use this tab is when a new camera is installed 
(1).  

Misc This tab is used when entering the license code (1). 

 

(1) For more information, see Installation Guide for XP available on the XP-Guide CD. 
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5.3.3 Other camera controls 

Camera info Informational messages from the camera control. 

Live Video 
Press this button to enable live video. The camera picture will be continuously 
updated. 

Snapshot 
One single picture will be taken. If a register mark is available in the picture, it will 

be detected. 

Adjust  offset Run wizard in order to adjust the offset of the camera. 

Calibrate 
Camera 

Run wizard to calibrate the camera. 
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5.3.4 Pre-defined register marks 

ArtiosCAD

 
 

When the position of the register marks is included in the Input file to XP-Guide, we call it pre-

defined register marks.  

 

From ArtiosCAD, a maximum of 4 pre-defined register marks can be added to the design.  

A description on how to generate register marks in ArtiosCAD is available from the document 

ServiceGuide_ArtiosCAD - Kongsberg on the XP-Guide CD. 
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5.3.5 Reading pre-defined register marks automatically 

 

Take care: 

 Knife blades are extremely sharp. 

 Keep away from all moving parts. 

 Ensure all other personnel stays in a safe distance from all moving parts. 

 Use ear protection. 

 

Select this alternative if: 

 

 An ARS – camera is available. 

 Standard register marks are available on the upward face of the material on the cutting 

table, visible to the camera. 

 Coordinates for the registration marks are defined in the input file. ArtiosCAD and Digital 

Flexo Suite are able to do so. 

 

 

5.3.5.1 Procedure 

 Prepare for the job as described in the User manual for XP. 

 Select Automatic operation and options as described in chapter „ARS – modes of operation‟ 

(40).  

 During execution, the register marks are examined one by one and compensations are 

calculated before the job is completed. 

 If, for any reason, the register mark is not detected, the execution will stop and a picture is 

displayed in the GUI. The following alternatives are available: 

1. If the register mark is visible inside the picture frame, position the mouse pointer in the 

center of the register mark and click the mouse. 

2. If the register mark is not visible, move the machine by manual jog until the register 

mark is inside the picture and press Start.  

3. Select Ignore this mark (this register mark) and press Start.  
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5.3.6 Reading pre-defined register marks manually 

 

Take care: 

 Knife blades are extremely sharp. 

 Keep away from all moving parts. 

 Ensure all other personnel stays in a safe distance from all moving parts. 

 Use ear protection. 

 

Select this alternative if: 

 
 Register marks are available, but the marks can not be recognized by the camera due to 

shape or lack of contrast. 

 Automatic register mark detection is not available. 

 Coordinates for the registration marks are defined in the input file. ArtiosCAD and Digital 

Flexo Suite are able to do so. 

 

5.3.6.1 Procedure using camera 

 Prepare for the job as described in the User manual for XP. 

 After Start, the execution will stop for each register mark and the camera picture is displayed 

in the GUI. Two alternatives are available: 

1. Use the register mark by mouse click 

 By manual jog, move the camera to a position where the register mark is 

inside the picture. 

 In the picture, move the cursor over the center of the register mark and press 

the left mouse button. 

 If the mouse-click was inside the green circle, the machine will move to the 

next register mark and the procedure is repeated. 

If the mouse-click was outside the green circle, the machine will move until the 

“click-position” is close to the center of the green circle. Now, move the cursor 

over the center of the register mark and press the left mouse button once 

more. 

 

2. Use the register mark by jog 

 By manual jog, move the camera until the centre cross is exactly on top of the 

register mark. 

 Press Start to continue execution. 

 

 After the last register mark is found, the compensation parameters are calculated and the job 

is completed. 



User Manual, Kongsberg XP 

 

 49 

 

5.3.6.2 Procedure using laser pointer 

 Prepare for the job as described in the User manual for XP. 

 After Start, the execution will stop for each register mark. 

 By manual jog, move the laser pointer into the center of the register mark. 

 Press Start to move to the next register mark and repeat the procedure. 

 After the last register mark is found, the compensation parameters are calculated and the job 

is completed. 

 

 

5.3.7 Reading manually defined register marks 

 

Take care: 

 Knife blades are extremely sharp. 

 Keep away from all moving parts. 

 Ensure all other personnel stays in a safe distance from all moving parts. 

 Use ear protection. 

 

Select this alternative if: 

 No pre-defined register marks are available in the input file. 

 

5.3.7.1 Procedure 

 Specify Manual Register mark input and other Registration setup parameters as described 

in chapter ARS – modes of operation (41). 

 Enter the X/Y distance from the register mark to design blank, see (41). 

 Depending upon the selected mode of operation, follow one of the procedures for reading 

pre-defined register marks as found in chapter „Work with ARS‟ (44).  
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5.3.7.2 Manually defined register marks - key parameters  

This chapter describes the work flow from Structural design through Graphical design and print and 

finally to Corrugated production and how the register marks are treated in the different steps: 

 

Structural design 

The structural design is prepared 

using a design software tool, as 
ArtiosCAD. 

The two register marks are 

positioned symmetric and in a 

known position relative to the 
design (Rx and Ry).  

In a company working with this 

system, one should standardize 

these values and use the same 
offset (Rx and Ry) in all designs. 

 Rx Rx

Ry Ry

 

Graphical design and print 

The graphical design is prepared 

using a graphical design software 
tool. 

The structural design template 

(output from the CAD system) is 

used to correctly position the 

graphics and the register marks 
relative to the structural design. 

G
ra

p
h

ic
s

G
ra

p
h

ic
s

 

Corrugated production  

On the Cutting table, the offset 

values Rx and Ry must be entered 
into the system.  

When the position of the register 

marks is obtained, offset Rx, Ry is 

used to position the structural 

design relative to the register 

marks. 

Rx Rx

Ry Ry

 

  

Rx, Ry - distance from Register mark to design blank 
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5.3.8 How to make the register mark visible on the up-ward side of the 

material 

 A typical use of this alternative is when the register mark is on the down-ward side of the 

material.  

 Use this procedure to make the register mark visible on the up-ward side of the material: 

 

 

This is the Register mark, which in this 

case will be on the down-ward side of 

the sheet when cutting and creasing is 

carried out. 

 

Place the sheet on a soft surface, and 

use an awl to make a hole through the 

material. 

 

Keep the awl vertical as you apply 

pressure. 
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On the rear side, use the awl to round 

the hole. 

Now, you have transferred the Register 

mark to the opposite side of the sheet.  

Repeat the procedure for the second 

Register mark. 
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5.4 Camera calibration 

 

Take care: 

 Knife blades are extremely sharp. 

 Keep away from all moving parts. 

 Ensure all other personnel stays in a safe distance from all moving parts. 

 Use ear protection. 

 

 

5.4.1 Introduction 

To achieve maximum accuracy when using ARS, the camera should be calibrated relative to the 

laser pointer. 

Camera calibration is a three-step process: 

 

Laser pointer

Knife tool used
for calibration

Camera to 

be calibrated

 

1) The knife tool to be used for camera 

calibration is calibrated relative to the laser 
pointer. 

2) The camera is calibrated relative to the knife 
tool. 

3) The camera position relative to the laser 

pointer is calculated based upon the previous 
two calibrations. 

 

Knife tool calibration is not included in this procedure; it is available in the Tool section. 

It is important that the knife tool calibration procedure is completed before this procedure is carried 

out: 
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5.4.2 Procedure 

Select the camera calibration wizard: 

Option->Registration setup (Alt+R)->Camera setup->Calibrate camera. 

 

 

1. Select the tool to be used when 

making a circle. Use a knife tool. 

2. Press Start to make the circle. 

3. Press Finish. 

4. Press Close to continue. 

5. Remove the material from inside the 

circle. 

 

 

 

The camera dialog will be shown with the circle inside the picture: 

 

 

1. If camera focus has to be adjusted, do 

it now by turning the camera lens in or 

out. 

2. Click the Snapshot – button and the 

machine will move to the next point. 

3. Continue to click Snapshot until all 

points are completed and the dialog 

disappears. 

4. The camera is now calibrated. 
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5.5 Adjust camera offset 

 

Take care: 

 Knife blades are extremely sharp. 

 Keep away from all moving parts. 

 Ensure all other personnel stays in a safe distance from all moving parts. 

 Use ear protection. 

 

Follow this procedure to calibrate the camera position relative to the other tools in the tool holder: 

 

5.5.1 General 

 
 As the camera is mounted outside the tool head cover, it is important that this 

test is carried out with the cover mounted. 

  All test files to be used are available from the folder: c:\xp-guide\iat 

 
 From Options->Table options, select Manual Vacuum control to ensure 

vacuum stays on during the complete procedure. 

  
 From Main Toolbar->Application selection, select Corrugated. 

  
 From Job View Toolbar-> Select Reference point, select Panel Ref. point. 

  For this procedure, use a thin sheet of carton (500 x 600 mm) as test material. 

  To continue in next chapter 
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5.5.2 Procedure 

 

Select Options->Registration setup->Camera setup->Adjust camera offset: 

 

 
 

The wizard will create a circle, which will be used for offset adjustment. 

 

From the drop-down menu in the dialog, select the tool to be used, preferably a knife. 

 

With a sheet of material on the table, switch Vacuum on. 

 

Jog to a proper position on the sheet and press Start. Note: In this case, the position is the position 

of the camera. 

 

The cross is made and the camera is positioned above the cross. The following dialog appears: 
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By Jog and Incremental jog, move the camera until the red marker is exactly in the center of the 

circle. 

 

In the dialog, press Finish. 

 

In the Continue Adjustment dialog, press Close. 

 

Switch Vacuum off. 

 

Now, the camera offset is properly adjusted. 
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5.6 Verify correct offset adjustment 

5.6.1 Draw the test figure 

1 Select No registration: 

Option->Registration setup (Alt+R)->No registration. 

2 Open the file regtestd.acm 

3 Place a sheet of carton, 400 x 400 mm, on the table. 

4 Switch Vacuum on to keep the sheet in a stable position. 

5 Configure Job setup to have a pen tool for line 1, 2 and 5. 

6 Jog to a start position (laser pointer) in the –X, -Y corner of the sheet. 

7 Press Init. 

8 Press Start to draw the file.  

 

5.6.2 Draw the test figure using registration marks 

1 Select Register mark input from input file and Camera detection: 

Option->Registration setup (Alt+R)->From input file. 

Option->Registration setup (Alt+R)->Camera detection. 

 

 

2 Open the file regtest.acm using the same Job setup (pen tool for line 1, 2 and 5). 

3 Move the machine to approximate the same position as used when the test figure 

was prepared and press Init. 

4 Press Start. 

5 The program will automatically read 4 registration marks and execute the file. 

6 Inspect the final result. Requirement: 

The angles prepared by this file should be positioned exactly on the two registration 

marks prepared by the first file. 
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6. Work with 123Box 

 

6.1 Introduction 

123Box is an add-on to the XP-Guide control software for Kongsberg cutting tables. 

 

The purpose of the program is to offer a simple work flow for preparation and production of standard 

corrugated and folding carton boxes. 

The solution is based upon a CAD-X implementation using ArtiosCAD functions to select a design 

from a library, enter dimensions and generate a cut-file. 

The cut-file is automatically opened in XP-Guide, ready to be cut on the Kongsberg cutting table 

(for description of ArtiosCAD and CAD-X, see separate chapters). 

 

It is a pre-requisite for this function that ArtiosCAD is installed and configured for CAD-X on the 

front end PC. 

In Service Guide for 123Box, chapter 3 and 4, you will find a description of how to install and 

configure the ArtiosCAD software. 

 

A license key is required for ArtiosCAD to run properly. 

 

6.2 ArtiosCAD, short introduction 

Design, Manufacturing and Communication for Packaging. 

 

 ArtiosCAD is the world‟s most popular structural design software for packaging design. 

 With dedicated tools specifically designed for packaging professionals for structural design, 

product development, virtual prototyping and manufacturing, ArtiosCAD increases 

productivity throughout your company.  

 ArtiosCAD is the ideal product for all corrugated, folding carton and POP display designers. 

Artios CAD's Design Modules are the best there are today.  

 The design and drafting tools of ArtiosCAD include functions that structural designers need to 

get their job done accurately and efficiently.  

 The tool alignment and snapping features provide graphical feedback, helping both 

experienced and new users immediately become more productive.  

 Complete 3D integration allows for quick prototyping of designs and presentations, 

eliminating communication errors and reducing design review cycles.  

 ArtiosCAD‟s layout and tooling design features can be used to create plate layouts and die 

tooling – optimized for the production equipment that will be used in manufacturing. 

 The integrated database and reporting features enhance communication within your company 

as well as with external suppliers. ArtiosCAD‟s Adobe® Illustrator® plug-ins truly creates the 

first round-trip workflow for structural and graphic designers. 

 

Key benefits  

 

 Superior drafting tools increase packaging designer productivity 

 Smart Standards save time and reduce errors  

 3D modeling and design provide fast prototyping and presentations  

 Powerful and efficient layout and tooling design reduce production costs  

 Relational database offers flexible library searches and reports  
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6.3 CAD-X, short introduction 

 CAD-X is a software module that makes it possible for other programs to use functions from 

within ArtiosCAD. 

 The CAD-X software is installed as part of XP-Guide. 

 It is a pre-requisite for CAD-X to run properly that ArtiosCAD is installed on the PC before 

installing XP-Guide. 

 

6.4 Work with 123Box 

6.4.1 Introduction 

The 123Box workflow can be illustrated as follows: 

 

XP-Guide 

settings

XP-Guide 

execution

Select and define 

a new box

CAD-X preview -

select Job setup file
 

 

This chapter will describe each step in detail. 

When all default settings are correct, the complete workflow is just a few steps illustrated as: 

 

XP-Guide 
settings

Press
Create a Box

XP -Guide 
execution

Press
Start

Select and define 
a new box

Select and define 
a new box

CAD-X preview -

select Job setup file

Press
Produce Box
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6.4.2 XP-Guide settings 

  

For 123Box, the following XP-Guide 
settings are necessary: 

 

From Option->System setup: 

 

• Enable CAD-X: must be enabled. 

 

From Main menu->File, select  

Create a box… or.. 

 

..press the  

Fileview toolbar->Create a box button. 
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6.4.3 Select and define a new box 

 

From the Create a box – function, the 
Standards catalogue dialog is displayed. 

Select Corrugated or Folding Carton. 

 

From the list of standard boxes, select the 
wanted standard (template) and press 

OK. 

 

Select the board to use and press OK. 

 

For setting of default parameters, see 

ServiceGuide_123Box, Chapter 3, Boards. 
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Enter the dimensions to use. 

 

Press Next to enter the next setup menu.  

 

Note:  

The number of menus and parameters 

depends upon the actual standard 
selected. 

Pressing OK will bring you directly to the 

CAD-X preview dialog. 

This is the recommended choice if you 
know that the default settings are correct 

for the rest of the parameters. 

 

Accept or select your preferences in the 
Style Choice menus and press Next. 

 

Pressing OK will bring you directly to the 

CAD-X preview dialog. 

This is the recommended choice if you 

know that the default settings are correct 

for the rest of the parameters. 

 

Check for correct settings and press Next. 

 

Pressing OK will bring you directly to the 

CAD-X preview dialog. 

This is the recommended choice if you 
know that the default settings are correct 

for the rest of the parameters. 
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Check for correct settings and press Next. 

 

Pressing OK will bring you directly to the 

CAD-X preview dialog. 

This is the recommended choice if you 

know that the default settings are correct 
for the rest of the parameters. 

 

Check for correct settings and press Next. 

 

Pressing OK will bring you directly to the 

CAD-X preview dialog. 

This is the recommended choice if you 

know that the default settings are correct 

for the rest of the parameters. 

 

Check for correct settings and press Next. 

 

Pressing OK will bring you directly to the 

CAD-X preview dialog. 

This is the recommended choice if you 

know that the default settings are correct 
for the rest of the parameters. 
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Check for correct settings and press OK. 

 

 

 

This is the CAD-X preview dialog.  

 

Press Job Setup if you want to verify or 

edit Tooling parameters here. (Could be 

done either here or in XP-Guide later in 
the process). 

 

When all settings are correct, press 
Produce Box.  

 

XP-Guide will be displayed with the design 

selected and displayed in Job view. 

 

If you want to look more at options 

available, see chapter CAD-X preview 
dialog. 
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7. System setup 

 

7.1 Introduction 

This chapter will explain all functions and parameters that are important for the XP system to run 

properly. 
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7.2 Reference Points and Coordinate System 

 

All X and Y coordinates in the Input File uses the selected Reference Point as origin. 

 

Two modes of operation are available: 

 

1) Fixed reference point 

 

 

Select a Reference Point from the Select Reference point drop down 
list. 

 

 

2) Panel reference point 

 

 

 From the Select Reference point drop down list, select Panel Ref 
Point.  

 Position the Laser pointer at the desired reference point. 

 Press Init. 

 

 

7.2.1 The Main Reference point position 

dx

X

Y

Working area

dy

Main reference point

 
 

 

 

The fixed reference point number 1 is defined as the Main Reference point. 

 

The other fixed reference points (2 – 10) are all specified relative to the Main reference 

point. Thus, moving the Main reference point will move these reference points as well. 

The Main reference point has to be correctly positioned in order to obtain: 

 A full working area. 

 Correct sheet feed operation. 
 Correct handling of long jobs 

Using the Main reference point during program execution ensures correct operation. 
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7.2.2 The Main Reference point for i-cut 

For i-cut to run properly, the Main Reference point should be set in a specific position on the table, 

using i-cut reference point setting wizard (72).  

After i-cut reference point setting, do not modify the position of the Main Reference point. 

If you need a reference point in another position on the table, use one of the other reference points 

available (2 – 10). 

 

 

7.2.3 Rulers and reference points 

The ruler system ensures an easy and correct positioning of the material on the table. 

 

dr dr = 10 mm / 0,4 inches.

X

Y

Working area

dr

Main reference point

 
 

The Main Reference point shall be defined 10 mm inside the ruler. 

 

 

When you use the lower right ruler, the Reference Point will automatically be moved to an identical 

distance from the right ruler, as it is defined from the left ruler. The lower right ruler is normally 

used for reverse score operations. 

At the same time the direction of the X axis is reversed. 

  

dr

X

Y

Working area

dr

Main reference point
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7.3 Speed Setup 

The Speed setup dialog is available from: 

 Main Menu->Options->System Option 

 CTRL+Alt+O 

 

Select the Speed Setup tab. 

 

7.3.1 Table Acceleration 

The Table Acceleration can be reduced to a % value of the maximum acceleration. 

  

Enter the wanted value in the Acceleration edit box. 

 

 

 

 

7.3.2 Continuous Jog speed 

The Continuous Jog speed can be reduced to a % value of the maximum jog speed. 

 

 
Enter the wanted value in the low Jog Speed edit box. 

 
Enter the wanted value in the high Jog Speed edit box. 

 

../Documents%20and%20Settings/jhbe/Application%20Data/Microsoft/Word/Operators_panel.htm#Continous_Jog
../Documents%20and%20Settings/jhbe/Application%20Data/Microsoft/Word/Operators_panel.htm#Continous_Jog
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7.3.3 Incremental Jog 

The size of the Incremental Jog movements can be customized. 

 

 
Enter the wanted value in the short Jog Increment edit box. 

 
Enter the wanted value in the long Jog Increment edit box. 

 

7.3.4 Jog directions 

 Specify jog direction for the Manual Jog buttons on the Operator panel. 

../Documents%20and%20Settings/jhbe/Application%20Data/Microsoft/Word/Operators_panel.htm#Incremental_Jog
../Documents%20and%20Settings/jhbe/Application%20Data/Microsoft/Word/Operators_panel.htm#Incremental_Jog
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7.4 Table setup 

 

The Table setup dialog is available from: 

 Main Menu->Options->Table Option 

 CTRL+R 

 

The following selections are available: 

 

 

7.4.1 Set Reference point 

The Set Reference point wizard is an aid for adding or 

changing the table reference points. 

 

Procedure: 

Press the Set Reference Points button to set up any 

fixed reference points. Follow the instructions given by 

the wizard and define the number of fixed references 

you want.  

As many as 10 points can be defined. 

Click the OK button. 

 

7.4.1.1 i-cut Main reference 

Press this button to establish the correct Main reference 

point for i-cut operations. 

 

7.4.2 Set Ruler Position 

If your table is equipped with rulers, please follow the 

procedure below. If not, enable the "Do not use rulers" - 

checkbox in the Set Ruler Position dialog. 

 

For the table to operate properly an exact registration of 

the ruler positions is necessary. This is a one time job, 

but it can be necessary to repeat the procedure if 

mechanical maintenance has been carried out on the 

table or traverse.  

Correct registration of the right ruler is required when 

reverse operations are carried out. 

 

 

 

Procedure: 

 

Press the Set Ruler Position button. Follow the instruction given by the wizard and define the left 

ruler position.  

Repeat the procedure for the right ruler.  

Note! When the right ruler is registered, use a position 100 mm out from the corner (marked on the 

ruler). 
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7.4.3 Table top reference 

Use this function to complete a tool height reference calibration.  

 

The tool height is measured in current position and the reference to the table top surface is updated. 

The Table top reference function should be carried out: 

 After mechanical adjustments of traverse or tool head. 

 When cutting through material is not working properly. 

 After any change of cutting / milling underlay, for instance, after adding or removing the 
milling underlay. 

Procedure: 

 

Remove all materials from the table surface. The cutting underlay remains in place.  

If the table is equipped with a conveyor belt, avoid measuring directly on the belt junction.  

Press the Table top reference button. In the wizard, press OK to start measurement. 

 

7.4.4 Map Table Top surface 

To assure correct cutting depth the surface of the table top is measured in order to create a map. It 

is recommended to execute this function if the cutting mat is worn out and after the cutting mat has 

been replaced. 

 

Procedure: 

If the table is equipped with a conveyor belt, move the belt junction away from the table surface. 

Press the Map Table Top Surface button. Follow the instructions given by the wizard. 

 

7.4.5 Register Table size 

This wizard moves the tool head from edge to edge of the table in order to measure the table size. 

This registration is normally done just once. 

 

Procedure: 

Press the Register Table Size button. Follow the instruction given by the wizard. 
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7.4.6 Adjust X1 to X2 angle 

Use this wizard to obtain correct angle between X axis and Y axis. 

 

 

Procedure: 

Press the Adjust X1 to X2 angle button. Follow the 

instructions exactly as given by the wizard.  

 

Note: Use drilled holes in table as reference (see picture). 

 

 

 

7.4.7 Calibrate foot on the measuring station 

Use this wizard to calibrate the height level of the measuring station. 

 

Procedure: 

Press the Calibrate foot button. Follow the instruction given by the wizard. 

 

Repeat this procedure after maintenance on the traverse, carriage or measuring station. 

 

7.4.8 Adjust measuring station position 

Use this wizard to calibrate the position of the measuring station to the system. 

 

Procedure: 

Press the Adjust measuring station position button. Follow the instruction given by the wizard. 

 

Repeat this procedure after maintenance on the measuring station. 

 

7.4.9 Vacuum control 

For details about this function, see separate chapter 'Vacuum control' (100). 

 

 

7.4.10 Conveyor belt control 

Split sheet feed 

The sheet feed movement is divided into two sequences. 

 

Sheet feed correction 

Adjust the movement of the conveyor belt to be shorter or longer. 
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7.5 System Options 

 

The System option dialog is available from: 

 
 Main Menu->Options->System Option 

 CTRL+Alt+O 

 

Select the System tab. The following selections are available: 

 

 

7.5.1 Display units 

Select unit to be used for the GUI. 

 

7.5.2 Language 

Select language for the GUI. 

 

7.5.3 Input File Format 

Select one of the available ACM or HPGL 

formats in the drop down list. ACM is the 

standard CAM format. 

 

7.5.4 Setup 

Enter this dialog for advanced input file 

format setting. 

For ACM and HPGL, use the setup dialog to 

specify the programming increment for the 

input file. 

For DXF, CF2, DDES, ARD, see ArtiosCAD 

User manual for more information. 

 

7.5.5 Enable CAD-X 

CAD-X enabled allows for the following input 

formats in addition to the formats 

mentioned above: DXF, CF2, DDES, ARD. If 

none of these formats are used, leave the 

function disabled. 

 

7.5.6 Origin in lower left corner 

Causes the entire input file coordinates to 

be offset, using the lower left corner of the 

job as reference.  
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The lower left corner of the job will now 

always be in the selected Reference Point. 

 

Note!  i-cut and ArtiosCAD users should 

leave this function OFF. 

 

 

 

 

 

7.5.7 Ignore Job Setup from Input file 

Inside an Input File, it is possible to specify a Job Setup file to be used during program execution. 

Enable this function to ignore the specified Job Setup file. 

 

Note: Most CAD systems do not add Job Setup file information to the Input File. 

 

7.5.8 Sequencing 

This function will sort the input file in order to minimize tool changes.  

The execution order will be determined by the tool type, so that pen is executed before crease which 

is executed before knife. 

Some functions depend upon sequencing being active, as reverse score. 

Note!  i-cut and ArtiosCAD users should leave this function OFF. 

 

7.5.9 Optimize tool use 

This function will reduce the movement with tool up to a minimum, making the execution on the 

table as fast as possible. 

Note!  i-cut and ArtiosCAD users should leave this function OFF. 

 

7.5.10 Check for critical geometry 

Optimizes cut directions for reduced paper tear hazards.  

Note!  i-cut and ArtiosCAD users should leave this function OFF. 

 

7.5.11 Remove double cuts 

This function will remove any double cuts. Used together with the layout function.  

 

7.5.12 High Quality, Normal, High Speed 

Select mode of operation. 



User Manual, Kongsberg XP 

 

 76 

 

7.5.13 Line to circle tolerance 

Specifies the maximum allowed arrow height A when straight lines are converted to circles.  

Maximum allowed arrow height value is 0.2 mm / 0.08 inch. 

 

A

 

7.5.14 Vacuum setup 

 

Pressing the Vacuum Setup - button opens up a new 

dialog where the vacuum section configuration for the 

actual machine is specified. 

 

This setup is a one-time job as long as the vacuum 

section solution on the machine remains un-changed. 

The setup should correspond to the actual hardware. 

 

The selected setup will determine which vacuum 

section configuration that will be available in the user 

interface.  

 

 

  

7.5.15 Router setup 

 

From the Router Setup dialog, the physical COM-port 

used for communication with the Milling Unit 

(HSMU/HPMU) is specified. 

 

Note 

The inverter needs to be connected to a genuine COM 

port. If connected to a USB-to-COM adapter, the 

communication will fail. 
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7.5.16 Park position 

Pressing the Park Position - button opens the Set Park Position dialog offering the following 

functions: 

 

Park position 

from file 

The park position is specified in the CAD system and transferred to XL via the 

input file. 

Go to 

reference 
point after job 

Move to the selected reference point after job finished. 

Selectable 
park position 

Enter co-ordinates (X,Y) for the park position. The co-ordinates are relative to 

the selected reference point. 

 

Set park position in current position. Press this button to established a park 
position 

in current laser pointer position. 

Park position 

at end of job 
The park position is in the lower right corner of the rectangle enclosing the job. 

 

 

 

 

7.6 Display colors 

The Display colors dialog is available from: 

 
 Main Menu->Options->System Option 

 CTRL+Alt+O 

 

Select the Display Color tab. 

 

 

This dialog defines what colors to be used for each line in Job 

Setup when a job is displayed in Job View. 

 

Colors are changed by clicking on any of the combo boxes and 

selecting the wanted color. Additional lines can be added at the 

bottom of the list. 
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7.7 Job Setup 

7.7.1 Introduction 

Job Setup is a table that links Logical tool numbers (P - numbers) in the Input File to tools on the 

machine and describes their behavior. 

 

The Job Setup information is stored as a file on the front end PC. 

 

Notes 

 All Job Setup files must have extension .mat 
 All Job Setup files have the identifier FMT 2000 as the first line in the Job Setup file. 

Typically, the Job Setup is different for the different materials used. Therefore, it is recommended 

to have one Job Setup file for each material type used. 

 

 

7.7.2 Select Job Setup files 

Selection of Job Setup files is available from: 

 

 

 Select a Job Setup file from the drop down list in Job View. 

 Invoke the Job Setup dialogue and select a Job Setup file from the 
drop down list in the dialogue. 
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7.7.3 Create and edit Job Setup files 

Job Setup is maintained from the Job Setup dialogue. 

 

The Job Setup dialogue is available from: 

 

  Main Menu->Options->Job Setup  

 
 The Job View tool bar button. 

  Pop up menu in Job View 

  Ctrl + J 

 

 
 

1. Job Setup is edited line by line. The parameters are described below. 

2. When finished editing, use the Apply function to save to current or to a new file name. 

3. Each line in Job Setup can be tested using the Test Line function. Follow the instructions in the 
dialog. 

 

7.7.4 Job Setup Parameters 

7.7.4.1 Depth unit 

Specify if the depth unit is mm / inch or percentage (%). 

 

7.7.4.2 Speed unit 

Specify if the speed unit is mm/min / ips or percentage (%). 

  

../Documents%20and%20Settings/jhbe/Application%20Data/Microsoft/Word/Job_View_descr.htm
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7.7.4.3 Line # 

Logical tools can be numbered from 1 to 99. A maximum of 30 logical tools are available. 

 

 

The color defined for each logical tool is displayed in Job View as shown.  

 

The color for each logical tool number is specified in Options->System Option. 

 

7.7.5 Tool 

Select the tool to be used for this line from the drop down list. 

 

7.7.6 Depth 

Depth can be set either in mm/inch or in % of material thickness. 

Different values can be entered for With and Across the Flute. 

 

 
With the flute 

 
Across the flute 

   

Entering a positive value specifies a depth measured from the top of the material, but: 

- For knife cutting, a value = 0 specifies through-cut. 

- For pen, crease, drill and router, a value = 0 specifies the top of the material. 

 

If you specify a T+/- value, the value specifies a distance from the cutting underlay. T0 specifies 

cutting or milling through the material down to the cutting underlay. 

A positive T-value will increase the cutting / creasing depth. 

Note: The T - function is available only when mm/inch is selected as depth unit. 

 

7.7.7 X/Y speed 

 

The speed can be reduced to an absolute value or to a percentage (%) of maximum speed, 

depending upon the 'Speed unit' setting. 

This value affects tool down movements only. 

  

7.7.8 X/Y acceleration 

 
The acceleration can be reduced to a percentage (%) of the maximum acceleration. 

This value affects tool down movements only. 
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7.7.9 Z-axis Speed 

 
The speed can be reduced to an absolute value or to a percentage (%) of maximum speed, 

depending upon the 'Speed unit' setting. 

  

7.7.10 RPM 

 Specify RPM for the HSMU/HPMU spindle. 

  

7.7.11 Laser pointer = Ignore 

This function specifies the behavior of lines with tool type 'No-tool': 

Function disabled - the line is executed using laser pointer (verify mode). 

Function enabled - the line is ignored during program execution (ignore mode). 

 

7.7.12 Knife before crease  

Use this function to force all knife movement to be executed before the crease movements.  

Normally this option should be turned off. It is recommended to use this option if the crease lines 

are done with a V-Notch tool. 

 

7.7.13 Test line n 

Select this function to execute a test figure with the selected tool n. 

The figure executed is a square 40 x 40 mm (1.6 x 1.6 inches). 

Use this function as a quick way to verify correct adjustments for the different tools.  

 

7.7.14 Circle adjustment line n 

 

The Circle lag parameter determines the quality 

of circles when cutting with knife. 

 

The value will be different for different materials. 

 

Complete this wizard to obtain a proper 

adjustment of the Circle lag parameter. 

 

Select between two different circle sizes, R=15 

and R=40 mm. 

 

Note: We recommend that the Circle lag value 

is set to 0 before the first figure is executed. 

  

!
 

 



User Manual, Kongsberg XP 

 

 82 

 

7.7.15 Extended.. 

For each line in Job Setup, an extended setup is available: 

 

 - This button face indicates that some of the extended parameters are set. 

 - This button face indicates that none of the extended parameters are set. 

 

 

 
 

The extended parameters are: 

 

7.7.15.1 Reverse score 

Enable this check box to specify that the tool shall work on the front side of the material. 

 

7.7.15.2 Stop before use 

When this function is enabled, the execution will stop at the beginning of this line and an operator 

message is displayed. 

The text to be displayed is entered into the User-defined text: – field. 

Note: Enable Sequencing if Stop before use is used in combination with Multi-pass (33). 
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7.7.15.3 Knife lift angle 

If the change in direction is above this value (in degrees), the tool is lifted. 

If the knife tool has a lag, the knife lift angle is 14 degrees. 

 

7.7.15.4 Perf pattern 

 

Specify a perforating pattern in the two edit boxes. The first specifies a tool 

up length and the second a tool down length. 

 

 

7.7.16 More 

 

The following functions are available 

through the More button: 

 

7.7.16.1 OverCut 

Check this box to enable or disable the 

Knife Over-cut function. Applies to knife 

tools only. 

Specify the size of the over-cut at start 

and end of consecutive cut lines.  

When the direction change between two 

consecutive lines is bigger than 13.5 

degrees, an over-cut corner action is 

performed. 

 

7.7.16.2 Arc to Line 

Arc to Line will apply to knife tools only.  

The radius is the maximum radius where 

the Arc to Line function will be executed.  

 

In order to make a more correct cut this 

function will minimize angular and 

sideways forces onto the cutting knife. 

This is achieved by splitting circles into 

straight line segments and turn the cut 

direction for each segment. Thus, the 

knife is lowered into the material where 

there is no cut before. 

 

 

 

 

7.7.16.3 Reciprocating knife with motor off 

Enable the function: 'Run reciprocating knife lines with reciprocation off' to run the Reciprocating 

knife with motor switched off. 
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7.7.16.4 Disable material thickness measurement 

When this function is enabled, no material thickness measurement is carried out. 

The following rules apply: 

 In Job setup, the T – function must be used for depth settings. 

 In Job setup, the Depths unit must be set to mm/inches (Percent not allowed). 

 During tool up movements, the knife is lifted to its top position. 

 

Note: This function is for knife tools only.  

 

7.7.16.5 Extra lift of tool 

Add extra lift height to tools when moved in up position. Useful for warped boards or uneven 

surfaces. 
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7.8 Job Layout 

 

XP-Guide can operate in either Single Design Layout mode or Multi Design Layout mode 

 

7.8.1 Single Design Layout 

 

Press the Single Design Button to select Single Design 

layout mode.  

When a design is opened in this mode it is always located 

relative the selected reference point. Only one design can 

be placed on the table. It can be further manipulated with 

Rotation, Scaling or with Step and repeat. 

 

 

7.8.2 Multi Design Layout 

 

Press the Multi Design Button to select Multi Design 

layout mode.  

When a design is opened from File view, the first design 

will be located relative to the reference point as in single 

design layout. The following designs will be placed 

according to the settings of the Job Layout Snap function.  

If a design is opened using drag and drop, it can dropped 

anywhere inside Job View.  

The bar on top of Job View is showing the name of the 

selected design. 

 

 

Note: 

 By using the Multi Design functions, you can locate your design anywhere inside the Job 

View area. The red and green “traffic light” will show if the work is inside the work area 

boundaries or not. 

 A combination of Multi Design and ARS is not supported. 

 

7.8.3 Multi design layout functions 

Note: All functions described here are available from Main Menu->Layout and from the Pop-up 

menu in Job view. 

 

7.8.3.1 Select a design 

A selected design is always shown in pink. After a design is opened it is always selected. It can also 

be selected by clicking on a line in the design or holding the left mouse button down and drag a 

square over the designs to select. 

 

7.8.3.2 Select all designs 

All designs are selected with Ctrl+A or by selecting Select All from the menus. 
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7.8.3.3 Delete selected designs 

Selected designs are deleted by pressing the Del key or by selecting Delete from the menus. 

 

7.8.3.4 Delete all designs 

All designs are deleted selecting the menu item Delete All. 

 

7.8.3.5 Rotate selected designs 

Selected designs can be rotated with the functions Rotate 90, Rotate 180 or Rotate.  

 

7.8.3.6 Positioning selected designs with the mouse 

Selected designs can be positioned by holding the left mouse button down on a selected element 

and move the mouse. They can be dropped anywhere or snapped to existing designs depending 

upon the Snap function settings. 

 

7.8.3.7 Positioning selected designs with the arrow keys 

Selected designs can be positioned with keyboard arrows and placed in the JobView depending upon 

the Snap function settings.  

The step size is defined in Job Layout Setup->Nudge. 

 

7.8.3.8 Step and repeat on selected designs 

In Multi Design layout, Step and Repeat works on selected designs only.  

 

 

7.8.4 Job Layout Setup 

 

Job Layout setup is available from Main menu-

>Layout or Ctrl+L. 

 

7.8.4.1 Snap 

The snap function is turned on and off by ticking 

the radio buttons on and off. 

 

7.8.4.2 Snap distance 

When the snap function is on, a design will be 

snapped to another design if it is positioned closer 

than the snap distance. 

 

 

7.8.4.3 Gap between designs 

This parameter defines the distance between designs after a snap function is completed. 
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7.8.4.4 Nudge 

Fine positioning with the arrow keys on the keyboard. 

 

7.8.4.5 Nudge step 

Defines the step the design is moved with when pressing an arrow key. 

 

7.8.4.6 Super nudge step 

Defines the step the design is moved with when pressing an arrow key together with the Shift key. 

 

   



User Manual, Kongsberg XP 

 

 88 

 

7.9 Tool Configuration and Adjustment 

 

The Tool Configuration dialog is used for all tool settings and adjustments. 

 

The dialog is available from: 

 
 Main Toolbar->Tool Configuration 

  Main menu->Option->Tool Configuration 

  Ctrl + T 

 

 
 

 

7.9.1 Tool configuration and user names 

The tool type mounted is identified by hardware codes in each tool.  

 

Current tool configuration is displayed under Identified tools. 

 

When a new tool is inserted, it will be identified to the system automatically. 

 

Use the Usernames edit boxes beneath each drop down box to give each tool a nickname you want 

to associate the tool with. 

By default the system creates a username from the tool type and its serial number. F.ex a knife with 

serial number 3020 will be named Knife 20 

 

All tools need to be adjusted in the position they will be used.  
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7.9.2 Adjust Active Tool 

 
 

From the Adjust Active Tool – dialog, all tool adjustment wizards are executed.  

 

The following procedures are general descriptions of how to adjust the tools. See the description of 

each tool type for more specific information: 

 

We recommend using a sheet of corrugated material, 5-6 mm / 0.2 inch, when executing the 

adjustments. 

Before any adjustment, complete a Table Top Reference function. 

 

7.9.2.1 Lag settings (for rotating tools) 

 

1. Select the tool to be adjusted. 

2. Press the Adjust active tool button to enter the wizard 

selection dialog. 

3. Select Lag settings. 

4. Follow the instructions given to enter correct values (90). 

5. Repeat the procedure for all rotating tools. 
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Lag setting dialog 

 

 

 

Lag test – see next picture 

 

Lag – lag value. This is the distance from the 

rotation center to the back of the knife blade. 

 

Enter the value as measured or as found using 

the Lag test. 

 

Width – knife bottom width 

Enter the measured knife bottom width. 

 

 

Lag test 

Run this wizard to obtain correct lag value. 

Follow the instructions in the dialog. 

Add the measured value to the displayed value. 

 

!
 

 

 

 

Circle lag 

 

Circle quality is determined by a parameter called Circle lag. The parameter value will vary 

depending upon the actual material. Therefore, the adjustment is located in the Job setup dialog 

(81).
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7.9.2.2 Tool height calibration 

 

  

 Knife blades are extremely sharp! 

 

XP is equipped with an Automatic tool height calibration system. Therefore, the system will run 

without any manual height calibration. 

If you, for any reason, would like to add an offset to the measured height, use the Tool Height 

Calibration dialog: 

 
1. Select the tool to be adjusted. 

2. Press the Adjust active tool button to enter the wizard selection dialog. 

3. Select Tool height calibration. 

4. Follow the instructions given by the wizard, step by step. 

5. Repeat the procedure for all tools. 

 

7.9.2.3 Rotation adjustment (for rotating tools) 

 

  

 Knife blades are extremely sharp! 

 

Optimal Angular offset may vary with different material strength and thickness. 

The adjustment can be done using the adjustment wizards, or by a manual adjustment procedure: 

 

Wizard adjustment 

 
1. Select the tool to be adjusted. 

2. Press the Adjust Active tool button to enter the wizard selection dialog. 

3. Select Rotation adjustment. 

4. Follow the instructions given by the wizard, step by step. 

5. Repeat the procedure for all tools in the toolhead. 

 

Manual adjustment 

1. Put an appropriate test material on the table, and switch vacuum on. 

2. From the Tool Configuration dialog, select one tool. 

3. Press the Adjust Active tool button to enter the wizard selection dialog. 

4. Select Manual adjustment of center offset and angle. 

5. Enter value for the Angular offset and select Activate. 

6. Note that the tool will rotate as the new value is activated. 

7. Press Tool override down, and Jog approximate 10 cm to make a test cut. 

8. Press Tool override down once more to lift the tool again. 

9. Press Tool override down once more to lower the tool again. 

10. Note how the knife enters into the material. 
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11. Press Tool override down once more to lift the tool again. 

12. If knife enters exact into the cut, the angle is correct, select Finish to exit. 

13. If seen in the cutting direction, the knife enters to the left of the cut, the Angular offset value 

should be decreased. Repeat from point 5. 

14. If seen in the cutting direction, the knife enters to the right of the cut, the Angular offset 

value should be increased. Repeat from point 5. 

 

7.9.2.4 Center Offset adjustment 

 

  

 Knife blades are extremely sharp! 

 

The adjustment can be done using the adjustment wizards, or by a manual adjustment procedure: 

 

Wizard adjustment 

 
1. Put an appropriate test material, that means a thin paper on the table (any significant 

material thickness will create a misleading offset in this wizard), and switch vacuum on. 

2. Select the tool to be adjusted. 

3. Press the Adjust Active tool button to enter the wizard selection dialog. 

4. Select Center Offset Adjustment. 

5. Follow the instructions given by the wizard, step by step. 

 

Manual adjustment 

1. Put an appropriate test material on the table, and switch on the vacuum. 

2. From the Tool Configuration dialog, select one tool. 

3. Press the Adjust Active tool button to enter the wizard selection dialog. 

4. Select Manual adjustment of center offset and angle. 

5. Enter value for the Center offset and select Activate. 

6. Note that the tool will move as the new value is activated. 

7. Press Tool override down, and Jog approximate 10 cm, to make a test cut. 

8. Press Tool override down once more to lift the tool again. 

9. Press the Jog button for the return direction shortly, just to turn the tool. 

10. Press Tool override down once more to lower the tool again, and Jog the same distance 

back. 

11. Press Tool override down once more to lift the tool again. 

12. Measure the distance between the two cuts. 

13. As a guideline, the distance should be 2 x material thickness. 

14. If exact, the Center offset is correct, select Finish to exit. 

15. If greater, the Center offset value should be increased. Repeat from point 5. 

16. If less, the Center offset value should be decreased. Repeat from point 5.
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7.9.2.5 Manual adjustment of Center Offset and angle 

 

Sometimes it might be necessary 

to fine-tune the adjustments 
obtained using the wizards. 

Use this dialog to modify the 

adjustment values for angle and 
center offset. 

 

1. Select the tool to be 

adjusted. 

2. Press the Manual 

adjustment of…. button to 

enter the adjustment dialog. 

3. Key in or use the up/down 

arrows to specify the 

wanted offset. 

4. Press Activate to enter the 

value. 

5. Test the new settings. 

 

 

Note:  

All XP tools should, by default, be close to correct angle when the adjustment value is 0. The 

Manual adjustment of…. function is useful if you want to test a tool for correct behavior before 

program execution. 

 

7.9.2.6 Offset adjustment 

1. Select the tool to be adjusted. 

2. Press the Adjust Active tool button to enter the wizard selection dialog. 

3. Select Offset Adjustment. 

4. Follow the instructions given by the wizard, step by step. 

5. Repeat the procedure for all tools in the tool head. 

 

7.9.3 More... 

The More... button opens the More.. dialog, which contains selections to ignore, delete or add to the 

tool list. The tool list contains tools that you can select for the tool positions. 
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7.9.3.1 Ignore the automatic tool identification 

The Ignore the automatic tool identification may be used when the automatic tool detection 

fails, and manually tool selection is necessary. Tick the box to avoid changing the tool setup when 

zero point sequence is running or tool identification button is selected. 

 

7.9.3.2 Delete tools 

The selection Delete tools may be selected when a tool is no longer in use. For example when the 

tool is returned to factory or is malfunctioning. The button Delete the tool remove the tool selected 

in the Tool dropdown list from the tool list. 

 

7.9.3.3 Add tools 

The selection Add tools may be selected to add new tools or tools that fail to be automatically 

detected. The button Add the tool attaches the tool selected in the Tool dropdown list to the tool list. 

   



User Manual, Kongsberg XP 

 

 95 

 

7.10 Board size 

The list of available board sizes is maintained from the Board size dialogue, available from: 

 

  Main Menu->Options->Board Size setup 

 
 The Job View toolbar button, select the Board Size tag 

  Pop-up dialog in Job View 

  Ctrl + J 

 

 
 

To edit already defined boards, edit the values directly in the table. 

To add new boards, go to the last line in the table and add the new material to the empty line. 

Press the Apply button to save the new values. 

 

Select the right board size from the Job View->Board Size drop down list. 

This will ensure a correct size of the displayed board in Job View. 

 

 

7.11 Change Flute/grain direction 

The flute / grain direction is altered from: 

 

  Main Menu->Options->Toggle Flute Direction 

    
 Job View toolbar-> Toggle Flute Direction 

  Pop-up dialog in Job View 

  Ctrl + F 

 

Correct setting of flute / grain direction is important in order to obtain correct cutting/creasing 

depth. 

../Documents%20and%20Settings/jhbe/Application%20Data/Microsoft/Word/Job_View_descr.htm
../Documents%20and%20Settings/jhbe/Application%20Data/Microsoft/Word/Job_View_descr.htm
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7.12 Transformations 

 

The transformation dialog is available from: 

 
 Main Menu->Options->Transformation 

 Ctrl + Alt + T 

 Pop-up dialog in Job view 

 

 

7.12.1 Scaling X/Y 

Enter a % value in the edit box to scale the 

design. 

A value less than 100 will decrease the size, 

and a value greater than 100 will increase the 

size of the design. 

Use the Up/down arrows to step the scaling in 

steps of 10%. 

 

 

7.12.2 Scaling X, Scaling Y 

Enter a % value in the edit boxes to perform differential scale of the design. 

Note:  

Unfortunately, the picture in Job view does not show the design with differential scaling, only 

common scaling. But the result on the table is according to the input. 

 

7.12.3 Rotation 

Enter a rotation degree value in the edit box to rotate the design. 

See table on next page for simple rotation angle calculation. 

Use the Up/down arrows to step the rotation in steps of 90 degrees. 

Example: 

A value of 90 will rotate the design 90 degrees in counter clock wise direction. 

You can enter both + and - values. 

 

7.12.4 Current Job Only 

Check this box to make these transformations valid for the current selected input file only. 
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7.12.5 Rotation angle calculation 

L
d v

X

Y

 

Use the table below to calculate the 

angle from a simple measurement. 

 

In a distance L from the lower left 

corner, measure the deviation from 

the horizontal line (d). 

 

Find the corresponding d – value in 

the table below and read the angle v 

in degrees. 

 

L = 1 m / 40 inches. 

 

d 

(mm) 

v 

(deg) 

 d 

(mm) 

v 

(deg) 
 d (in) 

v 

(deg) 
 d (in) 

v 

(deg) 

0,5 0,029  20 1,146  1/64 0,022  21/32 0,940 

1 0,057  21 1,203  1/32 0,045  11/16 0,985 

1,5 0,086  22 1,260  1/16 0,090  23/32 1,029 

2 0,115  23 1,318  3/32 0,134  3/4 1,074 

3 0,172  24 1,375  1/8 0,179  25/32 1,119 

4 0,229  25 1,432  5/32 0,224  13/16 1,164 

5 0,286  26 1,489  3/16 0,269  27/32 1,208 

6 0,344  27 1,547  7/32 0,313  7/8 1,253 

7 0,401  28 1,604  1/4 0,358  29/32 1,298 

8 0,458  29 1,661  9/32 0,403  15/16 1,343 

9 0,516  30 1,718  5/16 0,448  31/32 1,387 

10 0,573  31 1,776  11/32 0,492  1 1,432 

11 0,630  32 1,833  3/8 0,537  1 1/8 1,611 

12 0,688  33 1,890  13/32 0,582  1 1/4 1,790 

13 0,745  34 1,947  7/16 0,627  1 3/8 1,969 

14 0,802  35 2,005  15/32 0,671  1 1/2 2,148 

15 0,859  36 2,062  1/2 0,716  1 5/8 2,326 

16 0,917  37 2,119  17/32 0,761  1 3/4 2,505 

17 0,974  38 2,176  9/16 0,806  1 7/8 2,684 

18 1,031  39 2,233  19/32 0,850  2 2,862 

19 1,088  40 2,291  5/8 0,895    
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7.13 Step and Repeat 

 

The Step and Repeat dialog is available from: 

 

 
 Job View tool bar button 

  Pop-up dialog in Job view 

 

 

Use this function to create multiple copies of a job.  

 

T - Trim (distance from sheet edge). 

G - Gap (distance between each item). 

 

7.13.1 Execute one at a time  

This function depends upon Sequencing being 

enabled. 

When enabled, one and one design is completed. 

If disabled, all crease lines in all designs are 

completed before the knife lines are carried out. 

 

 

 

7.13.2 (XxY) 

The Step and Repeat layout is available in two modes, determined by the (XxY) check box: 

 

7.13.2.1 (XxY) disabled 

Select a suitable board size, and specify the number of copies in the Number of Copies edit box. 

The number of copies will be distributed on the specified board with Y-axis priority, that is, one Y-

column of jobs will be filled up before a new one is established. 

 

7.13.2.2 (XxY) enabled 

You specify the number of copies in the #X and #Y edit boxes. The total number of copies will be X 

x Y. 

The job will be distributed in X columns and Y rows regardless the size of the board. 

The Execute one at a time checkbox determines whether each copy should be completed before 

moving on to the next. Alternatively, all crease operations for all copies are completed before 

moving on to knife operations, and so on.  

 

Note: If Sequencing is disabled, job execution will be as Execute one at a time. 
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7.14 Counter setup dialog 

 

This function is available when Application is set to Folding Carton from: 

 
 File View toolbar->Matrix 

  Options->Counter setup 

 

 

 

The Counter function is used when the job is executed 

on top of a matrix.  

The purpose of this function is to avoid cutting 

through the matrix.  

 

7.14.1 Counter thickness, Automatic, minimum value 

Used when the thickness of the matrix and the material to be cut is equal. The thickness of the 

matrix and the material will be measured. The cutting depth is set to the half of the measured value.  

If the matrix thickness in this manner becomes less than the minimum value specified, the value 

specified will be used.  

The minimum value should be within 0.1 - 8 mm (0.004 - 0.3 "). 

 

7.14.2 Counter thickness, fixed value 

The specified value is used as the matrix thickness. The fixed value should be within 0.1 - 8 mm 

(0.004 - 0.3 ") 

 

7.14.3 Counter function enabled 

Use this check box to enable/disable the counter function. The Matrix button in the File View 

toolbar will change face accordingly: 

 

 
The Counter function is available, but disabled. 

 
The Counter function is enabled. 

 

 



User Manual, Kongsberg XP 

 

 100 

7.15 Vacuum control 

  

Note: Vacuum quick release and vacuum section selection will not work before the Vacuum push-

button on the Operator panel has been operated once.  

  

7.15.1 Vacuum control modes  

Two control modes are available, selectable from the Option->Table setup - dialog: 

 Disable 'I Cut controlled' function to select XP vacuum control. 

 Enable 'I Cut controlled' function to select i-cut vacuum control. 
 

7.15.2 XP vacuum on/off control   

 

From Option->Table dialog, two modes of vacuum 

control is available: 

 Manual (the Manual control function is 

enabled):  

Vacuum on / off is controlled from the Vacuum 

push-button on the Operator panel. 

 

 Automatic (the Manual control function is 

disabled).  

The function is illustrated as follows: 

 

 

30 min

Job Timeout

A E

B C D  
 

A Vacuum is switched on using the Vacuum on push-button. If no job is started within 30 min. 

after the vacuum is switched on, the vacuum pump is switched off automatically (E). 

B A job is started. The vacuum pump will be started automatically. 

C The job is finished. 

D The vacuum pump is switched off a time 'Timeout' after the job is finished. The time is 
entered in the Vacuum control dialog shown above. 
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7.15.2.1 Vacuum quick release mode (option) 

 

Enable the vacuum quick release mode by pressing the Vacuum release push-

button. The function is enabled when the button lamp is lit. 

  

If you are in the Vacuum quick release mode and the vacuum is switched off using 

the Vacuum on push-button, a valve will open to allow a quick release of vacuum 

inside the cutting table. 

When vacuum is switched on again, the valve will close. 

 

7.15.3 i-cut vacuum control 

Pressing the Vacuum on pushbutton will start the vacuum pump. Pressing the button a second time 

will stop the pump. 

Pressing the Vacuum release pushbutton on the Operator panel will open the vacuum valve to allow 

quick release of the vacuum inside the cutting table.  

 

Pressing the button a second time will close the valve and provide vacuum on the table as long as 

the pump is running. 

Note: When running i-cut, the 'i-cut vacuum control' should be enabled. 

 

7.15.4 XP using two vacuum pumps 

 

If your XP is equipped with two vacuum pumps (option), a pump 

enable / disable setting is available in the Table setup dialog: 

 Enable 2 vacuum pumps 

 Select if pump 1 or pump 2 or both should start when Vacuum 

on is pressed. 

 If both are selected, start of the second pump will be delayed.  
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7.15.5 Vacuum section selection 

 

Press Vacuum Section Selection button to enter the 

Vacuum Section Selection dialog: 

 

 

 

 

From this dialog, you prepare a suitable vacuum - area 

on the table by selecting vacuum sections.  

The numbers correspond to the Cutting Table as shown 

in the picture below. 

 

Press a button once to enable a section, push the button 

a second time to disable. 

 

 

 

 

 
  

  

Note: The vacuum section configuration depends upon the actual delivery. Only one max-

configuration is shown here. 
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8. Tooling system, introduction 

 

 

Laser radiation. Do not stare into beam! 

The tool head is equipped with a class II laser pointer. 
Emitted laser power < 1 mW. 

 

Knife blades are extremely sharp. Therefore, take care 

when handling knife tools. 

 

8.1 Tool handling and care 

All tools are precision instruments and should be treated as such to ensure proper operation. 

Take special care when: 

 
 Tools are inserted or removed from their stations. No excessive force should be applied. 

 Tools should not come in contact with hard surfaces while removed from their stations either 

temporarily or for storage. 

 The tools and their stations should be kept clean with a soft brush. 
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8.2 Tool configuration 

Kongsberg XP offers two different tool positions, P1 and P2, where different interchangeable tools 

can be mounted.  

In addition, there are separate fixtures for laser pointer, measuring foot, camera, drill and pen tools:  

 

P1
L

M

1
2
3

P2

 

  

L - Laser pointer 

M - Measuring foot 

  

Symbols used: 

1 - Tool alignment  

2 - Tool fixture 

3 - Tool fixture 

A CB D

 

A – P1 tool position, see table below 

B – camera position 

C - drill / pen / ink tool holder position 

D - P2 tool position, see table below 

E

 

  

There is a space reserved for future tools in the E - 

position.  

Technically, it is possible to put P2 - tools here, but 

none of the tools available now will work in this 

position. 
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The following tool configuration is available: 

 

Tool type Available tool inserts P1 P2 

   

HDU - Heavy-Duty Unit 
HD Crease 

V-notch knife 

HD knife tool 

   

Yes 

  

Foam Cutting Unit   Yes   

HD knife tool   Yes   

HSMU – High Speed Milling Unit   Yes   

HPMU – High Power Milling Unit   Yes   

VibraCut knife tool     Yes 

HF VibraCut knife tool     Yes 

Hi-Force knife tool     Yes 

RM knife tool     Yes 

RotaCut knife tool   Yes 

PressCut tool   Yes 

    

Drill / pen holder Drill tool 

Ball point pen 

Ink tool (Fiber tip tool) 
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8.3 How to replace a tool 

 

When mounting a tool head onto the Z1 or Z2 tool 

positions, ensure that the alignment pins and the 

electrical connector on the tool head fits those on the 

bracket. 

 

Use an Allen key, 6 mm, to fix the tool head.  

 

Ensure both screws are properly fixed. 

 

 

8.4 Two or more tools of the same type 

Each tool is identified to the system by type. In addition, it is possible to identify up to four different 

tools of the same type. 

One example: If you have two different Static knife tools, you can specify one to be number 1 and 

one to be number 2. In this way, all adjustment parameters will be stored and recalled automatically 

as the tool is mounted onto the machine. 

 

How to define individual tool numbers 

 

 

Inside each tool, there is a Tool Board.  

 

By means of dip-switches, you can specify  

4 unique tool numbers as illustrated at left. 

 

The different tool numbers are defined as follows:  

  Tool board switch 

setting 

Tool 1 1 & 2 off 

Tool 2 1 on & 2 off 

Tool 3 1 off & 2 on 

Tool 4 1 & 2 on 
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Note: Depending upon the tool type, 2 or 4 individual tools can be specified. 

 

8.5 Measuring station 

XP is equipped with a Measuring station: 

 

Measuring station

 

The Measuring station eliminates the manual adjustment of 
tool height. 

  

The Measuring station covers the following functions: 

 Calibrates the Measuring foot. 

 Automatically measures the height of the tool tip. 

If you, for any reason, would like to add an adjustment 

value to the measured value, a height adjustment dialog is 
available from the Tool Configuration menu.  

 

  

 The measuring sequence is carried out as follows: 

 During the first Table zero sequence after power on. 

 After any tool change and the tool is not calibrated. 

 After the safety system has been broken for 30 sec. or more. 

 After the servo system has been off for 30 sec. or more. 

 

It is possible to start a tool measuring sequence manually, see Forced tool height measure (38). 

 

8.5.1 Tool depth and measuring station 

 

Be aware how the Measuring station is 

working; it is the tool tip that is measured. 

Depending upon the actual tool, it might be 

necessary to add depth in order to achieve cut 

or drill hole through the material. 

 

Additional depth is entered in two ways: 

1. The general depth of a tool is entered in 

the Tool height wizard available from the 

Tool Configuration menu (88). 

2. The depth for a certain material or job is 

entered in the Job setup dialog (78). 
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8.6 HDU - Heavy-Duty Unit 

 

  

 Knife blades are extremely sharp! 

 

8.6.1 Description 

   

HDU with V-notch HDU with ø150 mm crease wheel 

 

  

The Heavy-Duty Unit is a single position tool head specially prepared for V-notch and HD knife tools.  

In addition, the tool head can be equipped with a ø150 mm crease wheel.  

For detailed description, see separate chapters for V-notch (112), HD knife tools (116) and ø150 

mm crease wheels (110). 
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8.7 ø150mm Crease Wheel 

8.7.1 Description 

  

 

A ø150mm Crease wheel mounted on an Heavy-Duty Unit. 

  

This crease wheel has the equivalent of 50kg [110lb.] of down-pressure. The additional pressure, 

combined with the large frontal area of the big wheel enables excellent crease quality in heavy-duty 

corrugated board and even permits creasing board with high recycle content without breaking the 

liner. 

A broad range of wheels with different shapes is available. 

 

8.7.2 How to mount / dismount the crease wheel 

   

Insert / remove the cotter pin. 

 

Insert / remove the latch pin. 
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8.7.3 Tool adjustment 

For this tool, complete the following adjustments: 

Lag setting  The lag value depends upon the blade adapter. Nominal value is 0 mm. 

Tool height Measured automatically, possible to add an offset value. 

Tool rotation Adjust tool angle tangential to moving direction. 

Center Offset Adjust tool sideways until centered. 

Tool Offset Adjust offset relative to laser pointer. 

For more information about how to run the adjustment wizards, see the Tool Configuration chapter 

(88). 
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8.8  V-Notch Knife tool 

 

  

Knife blades are extremely sharp! 

 

8.8.1 Description 

 
 

The V-notch knife tool mounted on a Heavy-Duty Unit. 

 

 

8.8.2 How to insert / remove the V-notch knife tool 

  

1 Turn the V-notch knife tool correctly to 
fit the alignment pin. 

2 Insert the first latch pin. 
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3 Insert the cotter pin. 4 Insert the second latch pin and cotter pin. 

 

 

8.8.3 How to replace a knife blade 

  

This picture shows how the knife blade is 

aligned using two guide pins beneath the 
blade clamping. 

1. Loosen the two screws (2) of the knife blade 
clamping. 

2. Carefully remove the blade (1). 

3. Insert a new knife and make sure that it is 

aligned with the alignment pins (3) in the tool 
head. 

4. Mount the new tool. (Note the position of the 
guide pin). 

5. Select Option, Tool Configuration (CTRL+T), 

Adjust active tool, Tool height calibration 

wizard, to assure correct height of the new 

knife.  
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8.8.4 V-notch knife, modes of operation 

 

Note: V-notch knife adapters for different angles are available. The programming and operation will 

be similar to the 45 degree version shown here. 

 

 

Single Cut 

Set from Job setup, Extended. 

  

  

 

Double Cut (1) 

This is the default mode if neither Single Cut nor 4-Cut are enabled. 

 

4-Cut (1) 

Set from Job setup, More V-notch. 

 

(1) – it is a pre-requisite for this function to work that the Sequencing function is enabled, set from 

System Option dialog (74). 

 

8.8.5 About tool adjustment 

 For the V-notch knife, we recommend the manual procedures for tool rotation and centre 

offset adjustment. 

 When adjusting tool rotation and centre offset, use a thin folded carton material. 

 Remember that you should look at the bottom side of the material for correct alignment. 

 The adjustment depends upon the actual material due to weight, structure and thickness. For 
optimal result, a fine tuning of the adjustments in the actual material should be carried out. 

 

For this tool, complete the following adjustments: 

Lag setting  The knife lag depends upon the blade adapter. Nominal value is 0-7 mm. 

Tool height Measured automatically, possible to add an offset value. 

Tool rotation Adjust tool angle tangential to moving direction. 

Center Offset Adjust tool sideways until centered. 

Tool Offset Adjust offset relative to laser pointer. 

For more information about how to run the adjustment wizards, see the Tool Configuration chapter 

(88). 
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8.8.6 How to set the depth of the V-notch knife 

1. The default depth of the V-notch knife is cut through the entire material. 

2. Define the depth of the V-notch cut in the Option, Job Setup (CTRL+J) 
3. Normally the cut should extend down to just above the bottom liner closest. 

 

8.8.7 How to set the width of the V-notch cut 

Enter Job Setup, More V-Notch to make adjustment to the default width. 

 

 

8.8.8 How to run the 4-cut function 

Enter Job Setup, More V-Notch to make adjustment to the default width. 

 

 

8.8.9 V-notch cut direction 

  

The blade angle and the cut direction must be taken 
into account when cut jobs are prepared. 

 

The arrow indicates the cut direction. 
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8.9 HD Knife Tool 

 

  

 Knife blades are extremely sharp! 

 

8.9.1 Description 

 
 

The HD knife tool mounted on a HDU. 

The HD knife tool is used for rigid board such as ReBoard and triple wall material. The tool is limited 

to straight lines longer than 50mm (2”). 

The tool is prepared for special, trapezoid shaped knife blades. 

 

8.9.2 How to replace a knife blade 

 
 

This picture shows how the knife blade is aligned 
against two alignment pins. 

Use these two screws to fix / release the 
knife blade. 
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8.9.3 How to insert / remove the HD knife tool 

  

 

1 Turn the HD knife tool correctly to fit the 
alignment pin. 

2 Insert the first latch pin. 

  

3 Insert the cotter pin. 4 Insert the second latch pin and cotter pin. 

  

  

For this tool, complete the following adjustments: 

Lag setting  The knife lag depends upon the blade adapter. Nominal value is 10 mm. 

Tool height Measured automatically, possible to add an offset value. 

Tool rotation Adjust tool angle tangential to moving direction. 

Center Offset Adjust tool sideways until centered. 

Tool Offset Adjust offset relative to laser pointer. 

For more information about how to run the adjustment wizards, see the Tool Configuration chapter 

(88). 
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8.10 Foam Knife Tool 

 

  

Knife blades are extremely sharp! 

 

Please note: Be careful where to place the tool head when not in use. 

 

If the tool head is left down on a table surface, the knife might be exposed, as the   

material hold down wheels moves up. 

 

 

 

 

8.10.1 Tool head mounting 

The Foam knife tool head is mounted onto the Z1 – carriage in 

the same way as the other Z1 tool heads. 

 

  

For this tool, complete the following adjustments: 

Lag setting  The knife lag depends upon the blade adapter. Nominal value is 3 (5) mm. 

Tool height Measured automatically, possible to add an offset value. 

Tool rotation Adjust tool angle tangential to moving direction. 

Center Offset Adjust tool sideways until centered. 

Tool Offset Adjust offset relative to laser pointer. 

For more information about how to run the adjustment wizards, see the Tool Configuration chapter 

(88). 
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8.10.2 How to replace a knife blade 

 

Loosen the fixing screw, replace the knife blade and fix it 

again. 

 

No additional adjustments are necessary, as the tool height is 

measured automatically. 

 

 

A set of knife protection handles are available.  

Use them for safe knife handling. 

 

When not in use, protect the knife blade using the handle. 

 

 

8.10.3 How to replace the knife adapter 

 

Loosen the fixing screw, replace the adapter and fix it again. 

 

No additional adjustments are necessary, as the tool height is 

measured automatically. 
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8.10.4 Disable material thickness measurement 

 

Set from Job setup -> More 

 

For the Foam Knife tool, the Disable material thickness 

measurement function is available. Use this function if  

 Your foam material is too soft for the measuring 

system.  

 The surface of your material is un-even. 

 

 

When the Disable material thickness measurement function is enabled, the following rules 

applies: 

 In Job setup, the T – function must be used for depth settings. 

 In Job setup, the Depths unit must be set to mm/inches (Percent not allowed). 

 During tool up movements, the knife is lifted to its top position. 
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8.10.5 Cutting quality 

To obtain best quality when cutting details, as small circles, we recommend: 

 Reduce the cutting speed (from Job setup). 

 Cut in two or three passes, each pass going a step deeper (Multi pass (33)). 

  



User Manual, Kongsberg XP 

 

 122 

8.11 HSMU/HPMU 

 

  Router bits are extremely sharp! 

 

Use Eye protection to prevent accidents caused by breaking milling bit 

or small pieces of processed material. 

  

 

8.11.1 Introduction 

Two different milling tool heads are available; HSMU and HPMU. 

Both models are covered by this chapter. 

 

 

8.11.2 Tool head description 

 

1. Suction house with brush for chip removal. 

During normal operation, the house is in 

down position. When changing bit, the 

house should be locked in its upper 
position. 

2. Air blow adjustment. Air blow is used for 

router bit cooling and to ease chip 

removal. Adjust for proper operation. 

There is also an air blow inside the spindle, 

but no user adjustment is necessary. 

3. Chuck open/close. The shown position is 

closed.  

Note: To protect the chuck from damage 

and the spindle from contamination, do 

not close the chuck empty over time. 

Never start the spindle without a bit / 

dummy bit in the chuck. 

4. Warning lamp for spindle running. 

5. Air clean button to help remove 
contamination. 

6. Locking screw for the suction house.  

Note: When in lower position, the house 

should be free to move up / down. 

Therefore, the house should never be 

locked when in lower position (HSMU). 

HSMU 

 

HPMU 
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1. Router bit. Shaft diameter is 6 mm 

(HSMU) and 6/8 mm (HPMU). 

2. Chuck. The HSMU/HPMU is equipped with 

one 6 mm chuck on delivery.  

3. Spindle 

 

 

 

8.11.3 Tool head mounting 

 

The HSMU/HPMU tool head is mounted 

onto the Z1 – carriage in the same way 

as the other Z1 tool heads. 
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8.11.4 Tool head park position 

 

Use the HSMU/HPMU park position for safe 

tool head storage. 

 

Note: 

For safety reasons, always use a dummy 

bit when parking. 

 

8.11.5 Vibration monitoring (HSMU) 

 

To protect the spindle, a vibration monitoring 

system is implemented.  

A warning will tell the user to reduce RPM. 

If very high level occurs, the machine will stop.  

See “HSMU precautions” (127). 
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8.11.6 HPMU specific issues 

 

8.11.6.1  Chiller / HPMU start up time 

Depending upon the environmental temperature, the chiller needs some start-up time after power 

on before it is ready to operate. Typical delay is 2 – 3 minutes. 

 

8.11.6.2  Suction house, adjustable height 

 

On HPMU, you can lock the suction house in any 
height; still it is allowed to move upwards. 

 

This function is useful in order to 

 Adapt to different material thicknesses. 

 Allow false air input in order to reduce suction 

force. 

 

 

 

8.11.6.3 RPM limitation 

Running 8 mm bits at a high RPM rate can generate vibrations and excessive wear. 

Using bits with extended lengths at high RPM can also be dangerous.  

Therefore, using long bits is subject to an automatic RPM reduction.  

If you are using short 8 mm bit, these must be limited manually to 40.000 RPM.  

In general, 6 mm bits are preferable in materials up to 20–25 mm thickness.  

 

 

8.11.6.4 Chiller error codes 

If any chiller failure occurs, look at the chiller display to see the real reason for the problem: 

 

 

Code Description 

E0 Sensor failure: cable defective, connection 
failure, sensor defective. 

IA Water level of water flow too low. 

 

HI Temperature of cooling medium too high 

 

LO Temperature of cooling medium too low 
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8.11.7 HSMU/HPMU - safety issues 

8.11.7.1 Suction house 

Always, when executing a job, let the suction house float on top of the material. In addition to chip 

removal, the house reduces the risk of being hit by small work pieces or by a breaking router bit. 

 

8.11.7.2 Eye protection 

Use eye protection when working with HSMU/HPMU.  

 

8.11.7.3 Hearing protectors 

The noise generated by HSMU/HPMU highly depends upon the material processed, and running 

parameters. Use hearing protectors when necessary. 

 

8.11.7.4 Spindle speed 

Never use speeds higher than recommended by the bit supplier. Special care should be taken when 

using bits with cutting diameter larger than shank diameter. 

 

8.11.7.5 Router bits 

Router bits are very sharp - handle with care.  

Never touch a rotating bit. Ensure the warning lamp is dark, and also observe that the bit 

is not rotating before approaching the bit.  

Always insert a dummy bit before dismounting a tool head from the machine. 

 

8.11.7.6 High temperatures 

Be aware that the HSMU may become hot during operation. 

 

8.11.7.7 Clean surface 

Keep the table and material surface clean, free from obstacles. 
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8.11.8 HSMU/HPMU precautions 

 

8.11.8.1 Spindle motor power consumption supervision 

 

The router is prepared for continuous operation between 0 – 100 % Watt. 

Too high spindle power consumption indicates critical conditions for the motor 

and immediate actions should be taken: 

 Use correct and sharp milling bit. 

 Use correct RPM for the actual bit and material. 

 Reduce the X/Y speed. 

 

If the motor is running above a critical limit, the execution will stop and a 
message is displayed. 

 

8.11.8.2 Use of non-balanced bits 

 

One-flute bits are by nature non-balanced, and may 

destroy the spindle if used wrong. 

Therefore, one-flute bits with cutting diameters 

above 4 mm, 5/32 inch must be run with a 

maximum RPM of  

40.000 (HSMU)  

60.000 (HPMU) 

 

 

8.11.8.3 Keep distance d small 

d

 

For best performance and minimum wear, do not let 

the bit stick out more than necessary. Use bits with 

short cutting lengths for thin materials. 
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8.11.8.4 Air valve operation 

 

Never operate the air valve while the spindle is running.  

 

This will destroy the spindle.   

 

 

8.11.8.5 Air pressure 

Never run IBAG spindle with air pressure disconnected 

This may destroy the spindle. 

Keep this in mind also for test purposes. 

  

 

8.11.8.6 Use clean air 

 

The spindle is sensitive for the pressurized air 

quality.  

Regularly check the air pressure reduction 

valve according to the maintenance section. 
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8.11.8.7 Maintain bit clamping 

 

Un-proper clamping may cause the bit to slip in the 

chuck and damage to the table top.  

1. Keep the bit shafts clean. Avoid greasy 

fingers. Clean the bit shafts with acetone if 

necessary, but use only dry cotton tips on the 

chuck.  

2. Maintain air supply pressure of 7 bar.  

Follow procedures for Chuck change and clean 

strictly. 

 

 

8.11.8.8 Operation at low and high temperatures 
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Never run a spindle when ambient temperature is below 10 °C, 50 °F. 

Continuous operation at temperatures above 30 °C, 86 °F is not 

recommended (HSMU)! 

HPMU spindle is water cooled, thus, the ambient temperature is not that 

critical for the spindle itself. 

 

 

8.11.8.9 Long term storage 

 

More than 4 weeks storage of a spindle or a 

HSMU/HPMU requires: 

 Turn the spindle by hand about 20 turn every 4 

weeks.  

 Spindle must be stored horizontally   
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8.11.8.10 Consider having a replacement spindle 

 

If the HSMU/HPMU is used in regular production, it 

is recommended to have a replacement spindle.  

The service interval will depend on the type of 

operation, and is difficult to predict. Indication of 

worn bearings may be increasing noise, increasing 

vibrations or decreasing surface finish.  

Note:  

When replacing a spindle, torque the motor clamp to 

5 Nm, 44 lbf-in using a torque wrench. This is a 

low torque for that screw size. 

Also check by hand that the spindle rotates smooth 

without any resistance. 

 

 

8.11.8.11 Empty vacuum cleaner in time 

 

Do not leave the machine running if the vacuum 

cleaner can go full.  

This might cause damage.  
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8.11.9 HSMU/HPMU routing advice 

8.11.9.1 Milling bits 

  

Use bits with short cutting lengths 

for thin materials. 

 

  

For best performance and 

minimum wear, do not let the bit 
stick out more than necessary. 

 

 

Never use higher RPM than recommended by the 

bit supplier. Special care should be taken when 

using bits with cutting diameter larger than 
shank diameter. 
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Bits with small cutting diameters (3-4 mm; 0.12-

0.16 in) are more balanced than bits with larger 

cutting diameters, and can be run with higher RPM, 

normally 60.000.  

Use large diameter bits (5-6 mm; 0.20-0,24 in) 

when needed to get rid of the chips in thick 

materials.  

Max RPM (HSMU) 40.000 

Max RPM (HPMU) 60.000 

 

 

Edges are brittle. Never let bits touch each other, or 

other hard surface. Always store in proper container.   

 

 

8.11.9.2 Acrylic or Multi Purpose bits 

 

Acrylic bits (A) are polished, extra sharp for Acrylic, 

wood etc.  

 

Multi Purpose bits (MP) have a higher wear 

resistance, and are suitable for aluface, plastics, 

MDF, plywood, wood etc.  

MP bits can be identified by a small tooth at the tip. 
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8.11.9.3 Feed rates 

 

 

One-flute bits do have a good chip flow, and allow 

for large feed rates. 0.1-0.2 mm/tooth (0.004-0.008 

in/tooth) can be a starting point for optimization in 

most materials: This gives a feed rate of of 4-8 

m/min (2.6-5.2 ips) at 40.000 RPM, and 6-12 m/min 
(3.9-7.9 ips) at 60.000 RPM.  

Light materials like PVC foam can be run much 

faster.  

The surface finish or the power consumption will 

normally determine the final feed rate for an 
application.  

A large drop in RPM, or a high %Watt value in the 

display, indicate too high feed rate. Large diameter 

bits require more power than small diameter bits. 

Worn bits increase the power consumption.  

 

 

8.11.9.4 Number of passes in thick materials 

The number of passes depends on material type, thickness and bit diameter. Use a pass depth that 

makes the groove free of chips, normally that is a depth equal to the cutting diameter. 

 

 

8.11.9.5 Material hold down 

Material hold down may be a limiting factor. Especially parts cut loose can be a problem if they are 

small. This can be done to improve the situation: 

 Use bits with smaller cutting diameter 

 Cover unused table area 
 Use wash-out functions instead of cutting loose small waste parts.  

 

8.11.9.6 Milling direction 

 

The milling direction is important in order to obtain a 
good result. 

Correct directions, especially in foam materials, are 

illustrated in the figure at left. 

The blue part is our product where we want the 
edges to be smooth and nice. 

Note 

Altering the milling direction is to be carried out in 
the CAD program. 

 

8.11.9.7 PressCut knife tool in combination with HSMU/HPMU 

It might be necessary to reduce the acceleration in order to achieve an optimal cutting quality when 

combining a heavy tool head with high quality cutting tools. 
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8.11.10 HSMU/HPMU - bits and bit change 

8.11.10.1 How to insert / replace a router bit 

 

Ensure the spindle is not running - lamp is dark. 

Mind the sharp bit, and move the suction house up. 

 

Lock the house in its up position. 

 

Observe that the bit is not rotating.  

Use a cloth to hold the bit.  

Move the lever down to open the chuck. 

Put the bit in a proper storage container.  

Insert a new bit. 

Close the chuck 
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Only the round part of the shaft should be inside the 

chuck. 

See the „HSMU/HPMU - bit length and position‟ – 

chapter for more information.  

 

Release the lock to allow the suction house moving 

down to its down position. 

 

Regularly, perform a chuck holder and chuck cleaning, 

following the dedicated procedure.  

 

Note: 

Never apply compressed air for cleaning. 
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8.11.10.2 If a bit is stuck 

 

If a bit is stuck in the chuck, the probable 

cause is low air pressure.  

To release a router bit from the chuck, a 

pressure of approximately 7 bar is required.  

If necessary, check the table regulator setting, 

or the pressurized air source. 

 

If the bit is still stuck, see the Chuck change 
and clean section how to unscrew the chuck. 
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8.11.11 Chuck change and clean  

Clean the taper and the chuck regularly for proper operation and optimum life time of spindle and 

chuck; at least once a week, but more often if necessary. Follow the procedure strictly.  

 

Normally, the chuck has a long lifetime. Extended vibrations or impacts may hurt the chuck, and 

cause bad milling results. Trying a new chuck is the easiest way to identify if the chuck is the 

problem. Running with a bad chuck will also increases the spindle wear. 

 

 

  

The IBAG chuck is lockable, meaning it needs 

no adjustment when entering the bit. 

  

Place the tool head on the table. 

Open the chuck and remove any bit.  

 

Note: 

Never apply compressed air for cleaning. 

 

Apply the 13 mm / 17 mm (HPMU) key to 
hold the spindle rotor.  

 

Note: 

Do not turn the rotor when in CHUCK OPEN 
position. This might damage the spindle. 
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Enter the chuck tool with a dummy bit to the 
chuck. 

 

Hold the rotor with the 13/17 mm key and 
unscrew the chuck with the chuck tool. 

 

Note: 

If you can not move the chuck with the chuck 

tool, another 10 mm (12 mm for HPMU) key 

might be used, together with a bit, to 

unscrew the chuck. This procedure might be 
necessary if a bit is stuck. 

 

Apply the taper brush to clean the taper.  

 



User Manual, Kongsberg XP 

 

 139 

 

Push the air clean button to help remove 
contamination.  

 

Clean the chuck. 

 

Apply small quantities of grease to the 

threads of the chuck when necessary. Avoid 

the clamping area. Do not use oil, as it could 

enter the clamping area and reduce the 

clamping force. Also apply small quantities of 

grease to the outer cone of the chuck. 

 

Torque up the chuck by hand, using the 

chuck tool and a dummy bit. (Maximum 

torque 2 Nm, 18 lbf-in). Hold the rotor with 
the 13/17 mm key. 
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Close the chuck on a dummy bit. 

 

 

Chuck maintenance kits are available on the 

Esko web shop, www.esko.com.  
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8.11.12 HSMU/HPMU - bit length and position 

d

 

Keep distance d small.  

For best performance and minimum wear, do not let 

the bit stick out more than necessary.  

Use bits with short cutting lengths for thin materials. 

e

 
For proper clamping, keep distance e 20 mm, 0.8 
inch as a minimum. 

d

 
To achieve material through-cut, the distance d must 
be at least 18 mm, 0.7 inch. 

fg

 

Balanced bits 

Bits with balanced surface should have a clamping 

length f of min. 20 mm/0.8 inches. Maximum 
balancing length g is 12 mm / 0.5 inches. 
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8.11.13 HSMU/HPMU - Tool adjustment 

  

8.11.13.1 Adjustments for the standard tool positions: 

 

For this tool, complete the following adjustments: 

 

 Tool height Measured automatically, possible to add an offset value. 

 Tool Offset Adjust offset relative to laser pointer. 

 

For more information about how to run the adjustment wizards, see the Tool Configuration chapter 

(88). 

 

 

Notes regarding Tool height adjustment: 

 

When properly adjusted, the router bit should barely touch the top surface of the material. 

 

Notes regarding Tool offset adjustment: 

 

Before executing the wizard for tool offset adjustment, the Job setup file has to be prepared 

as follows: 

 

 
 

In the first line in Job setup, specify HS milling tool with parameters as illustrated. 

Then execute the wizard for tool offset adjustment. 
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8.11.14 HSMU/HPMU - Job setup 

 
 

General information about the job setup dialog is found in the 'How to..' chapter.  

In this chapter, only the Router tool specific issues are described:  

 

 
Specifies the router depth measured from the top of the material. The depth is specified 
as an absolute value in mm or inch, or i % depending upon the 'Depth unit' setting. 

 
Not used. Will display the same value as entered in the above line. 

 
Specify X/Y speed in % or m/min ( ips ). 

 
Specify X/Y acceleration in % 

 
Specify Z-axis speed in % or m/min ( ips ). 

 
Specify speed in RPM for Router spindle. 
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8.11.15 HSMU/HPMU - Table top and height adjustment 

 

8.11.15.1 The following rules apply when adjusting HSMU/HPMU: 

   

T

C
Map table top

 
  

T = Cutting table 

C = Cutting underlay 

 

Map table top function is carried out on top of the Cutting 

underlay. 

   
Table top reference

CU

 
  

U = Milling underlay 

 

The Table top reference function is carried out on top of the 

Milling underlay 

  

 

  

  

The tool height is measured automatically. 

 

If, after a test cut, you want to modify the milling depth, this 

is possible from the tool height adjustment dialog. 

 

8.11.15.2 The following rules apply when milling: 

   

C

Mill on cutting underlay
M

 

  

Mill on cutting underlay (C): 

 

To avoid damage to the cutting underlay, the downward 

movement of the drill-bit is stopped 2 mm / 0.08 inch above 

the cutting underlay. 

Thus, it is not possible to mill through the material in this 

case. 

Tool height will follow the mapped tabletop. 

   

Milling underlay on top 
of cutting underlay

M
CU

 

  

Milling underlay (U) on top of the cutting underlay: 

 

To be able to mill through the material, the thickness of the 

milling underlay must be > 2 mm / 0.08 inch. 

If the thickness of the milling underlay (U) is < 5 mm ( 0.2 
inches ), the tool height will follow the mapped table top. 

 

Stiff underlay on top of 
cutting underlay

M
C

S

 

   

 

  

A stiff milling underlay (S) on top of the cutting 

underlay: 

 

If the thickness of the milling underlay (S) is > 5 mm (0.2 

inch), the underlay is supposed to be more or less stiff. 

One typical milling underlay material is MDF, face milled on 

top. 

 

In this case, when the underlay is supposed to be stiff, the 
measured 'table top reference' value is used for height control 
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8.11.16 Face milling 

For face milling, an acm - file prepared for the actual material is required. A program dedicated for 

this purpose is installed together with XP-Guide.  

   

Procedure:  

   

Generate acm - file 

From the desktop, double click the icon 'FaceMill'. 

The FaceMill user interface appears on the screen. 

Fill in relevant information and generate a new acm - file. Press the 'Help' button to get information 

about the different parameters.  

 

XP-Guide 

In XP-Guide, disable the 'Origin in lower left corner' function. 

Prepare a job setup file. 

A reduced acceleration is recommended (30 - 50 %). It will improve the surface quality. 

  

8.11.17 Square cut-out 

To prepare an acm - file for simple cut-out of a square, a dedicated program is available: FaceCut. 

This program is installed together with XP-Guide. 

  

Procedure:  

 
Generate acm - file 

From the desktop, double click the icon 'FaceCut'. 

The user interface appears on the screen. 

Fill in relevant information and generate a new acm - file. Press the 'Help' button to get information 

about the different parameters.  

 

XP-Guide 

In XP-Guide, disable the 'Origin in lower left corner' function, and prepare a suitable job setup file. 
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8.11.18 Miscellaneous 

8.11.18.1 Warm Up 

To protect the spindle, mandatory WarmUp is implemented.  

 

If the spindle has been inactive for 8 hours or more, a 3 min. WarmUp is required.  

WarmUp is started with this button: 

 

 
 

If the spindle has been inactive for 4 weeks or more, an extended sequence is required, called 

RunIn. This takes 20 minutes. 

 

8.11.18.2 Suction house 

Clean the suction house when necessary with acetone and a q-tip. A smooth surface will ease the 

chip removal.  

 

8.11.18.3 Vacuum clean the milling underlay 

 

The vacuum cleaner can be used for automatic 
cleaning of the felt:  

Use the FaceMill.exe to make a file that covers 

the actual area. Set “bit size” to 65 mm (2.5 

inch), and set trim sizes to zero. Hint: Make a file 

name that reflect the size used. Make a job setup 

file with low spindle speed, zero depth, and 

maximum feed. Insert the dummy bit into the 

chuck, and adjust tool so the brush is working 

properly.  
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8.12 The VibraCut knife tool 

 

 

  

 Knife blades are extremely sharp! 

 

8.12.1 Description 

The VibraCut knife tool is available in two models: 

 

VibraCut knife tool 

 

 
 

Running with 6000 RPM and amplitude +/- 0.15 mm (0.006 inches), this tool is recommended for 

light duty corrugated materials. 

 

 

High Frequency VibraCut knife tool 

  

 
 

Running with 12000 RPM and amplitude +/- 0.6 mm (0.024 inches), this tool is recommended for 

more demanding corrugated materials. 

Note: Hearing protection is recommended when working with this tool. 

 

Common to both models: 

 

 To reduce material tear, a foot is available. 

 The same set of knife adapters can be used. 
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8.12.2 Replace knife blade 

 

Remove the foot by pulling the foot straight 

out. 

 

Loosen the screw A and replace the knife. 

Ensure the knife has correct position relative 
to the screw. 

Push the knife down while the screw is fixed.  
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Extreme care should be taken when inserting 
the knife foot again. 

Keep fingers away from knife as illustrated at 

left. 

  

 

8.12.3 Tool adjustment 

 

For this tool, complete the following adjustments: 

Lag setting  The knife lag depends upon the blade adapter. Nominal value is 0-3 mm. 

Tool height Measured automatically, possible to add an offset value. 

Tool rotation Adjust tool angle tangential to moving direction. 

Center Offset Adjust tool sideways until centered. 

Tool Offset Adjust offset relative to laser pointer. 

For more information about how to run the adjustment wizards, see the Tool Configuration chapter 

(88). 
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8.13 RM Knife Tool (Rigid Material) 

 

  

 Knife blades are extremely sharp! 

 

 
 

8.13.1 Insert / remove knife blade 

 

 

Use a 3 mm Allen key to fix / loosen the knife 
blade. 

Ensure the blade is correctly aligned. 

 No additional adjustments are necessary, as the tool height is measured automatically. 

  

8.13.2  Tool adjustment 

For this tool, complete the following adjustments: 

Lag setting  The knife lag depends upon the blade adapter. Nominal value is 0-4 mm. 

Tool height Measured automatically, possible to add an offset value. 

Tool rotation Adjust tool angle tangential to moving direction. 

Center Offset Adjust tool sideways until centered. 

Tool Offset Adjust offset relative to laser pointer. 

For more information about how to run the adjustment wizards, see the Tool Configuration chapter 

(88). 
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8.14 The Hi-Force knife tool 

 

  

 Knife blades are extremely sharp! 

 

8.14.1 Description 

  
 

The Hi-Force knife tool is a general purpose knife tool suitable for cutting a wide range of materials. 

As the name indicates; this tool is prepared for a higher tool pressure compared to the Static knife 

tool. 

The tool is prepared for a wide range of knives. 

To reduce material tear and also to keep the material down as the knife is pulled out, a foot is 

available. 

 

8.14.2 Replace knife blade 

 

Remove the foot by pulling the foot straight 

out. 
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Loosen the screw A and replace the knife 

blade. 

Push the knife blade against the bottom of 

the slit while the screw is fixed.  

 

Extreme care should be taken when inserting 

the knife foot again. 

Keep fingers away from knife blade as 

illustrated at left. 

  

 

8.14.3  Tool adjustment 

For this tool, complete the following adjustments: 

Lag setting  The knife lag depends upon the blade adapter. Nominal value is 0-3 mm. 

Tool height Measured automatically, possible to add an offset value. 

Tool rotation Adjust tool angle tangential to moving direction. 

Center Offset Adjust tool sideways until centered. 

Tool Offset Adjust offset relative to laser pointer. 

For more information about how to run the adjustment wizards, see the Tool Configuration chapter 

(88). 
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8.14.4 Replace knife adapter 

 

To remove the knife adapter, just pull it out 

from the holder. 

  

  

  



User Manual, Kongsberg XP 

 

 154 

8.15  PressCut knife tool 

 

  

 Knife blades are extremely sharp! 

 

8.15.1 Description 

 

 
 

The PressCut tool is a special knife tool for vinyl cutting. 

The cutting depth is controlled by the downward knife pressure. The pressure is adjustable from the 

XP-Guide Job setup dialog. 

For applications where a more accurate depth control is required, a simple foot solution is available. 

The tool is prepared for a wide range of knife blades. 

 

8.15.2 Replace knife blade 

A

 

  
This figure shows how the knife is fixed 

inside the PressCut knife tool. 

The friction between the alignment pin A 

and the knife keeps the knife blade in 

place. 

 

A special hand tool is available as an aid when 

replacing knives. Use this hand tool when removing 

and inserting knives into the tool. 

 

When inserting a new knife, ensure the knife is 

correctly positioned relative to the alignment pin. 
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8.15.3 Tool pressure 

The PressCut tool can run with a constant tool pressure or a speed dependent tool pressure. Both 

parameters are specified in the Job setup structure. 

 

8.15.3.1 PressCut knife down force 

 

Specify the knife pressure when running the PressCut knife tool. The pressure is entered 

as a gram - value from 50 to 700 grams. 

The knife pressure is modified if a "Speed dependent pressure" is specified, see below. 

The tool pressure specified in the Job setup structure is automatically adjusted. During the tool 

down movement, the PressCut tool moves down until the material surface is detected and the 

proper knife pressure is achieved.  

The tool pressure will vary depending upon the material. For a typical vinyl cutting job, a 

recommended start parameter is Pressure = 65-70 gram and Speed dependent pressure = 50%. 

 

Note: For the PressCut knife tool to work properly, a sharp knife is very critical. Pay special attention 

to the tip of the knife, as it is easy to break. 

 

8.15.3.2 Speed dependent knife down force 

 

 

The Speed dependent pressure function adds pressure to the PressCut knife tool 

depending upon the speed of the machine.  

The function can be illustrated as follows: 

 

 

The upper curve illustrates the speed of the machine 

when executing a line. 

 

Curve A illustrates the knife pressure if the Speed 

dependent pressure is set to 0; the pressure is constant 

from start to stop. The pressure level is as specified by 

the "PressCut knife down force" parameter, see previous 

chapter. 

 

Curve B illustrates the knife pressure when the Speed 

dependent pressure is set to 100.  

When running at full speed, the pressure is the double of 

the "PressCut knife down force" A. 

 

This function is useful as it allows a lower pressure in 

both ends of a line where the speed is low at the same 

time as you get a higher pressure when running at full 

speed. 

 

Note:  

The maximum Speed Dependent Pressure is 200%. 
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8.15.4 Foot solution 

d

S

 

Normally, the PressCut knife tool is used 

without the foot mounted. 

 

When the foot is mounted, the cutting depth d 
is controlled by the adjustable screw S. 

 

 

Procedure: 

 

1 - Press the clamp C as indicated to lock the 

knife shaft. 

 

2 - Turn the screw S to adjust the cutting 

depth.  

When seen from the knife side, a clockwise 
adjustment will increase the cutting depth. 
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8.16  RotaCut knife tool 

 

  

 Knife blades are extremely sharp! 

 

8.16.1 Description 

 
 

The RotaCut knife tool is a special tool for cutting light materials, as thin fabric.  

Maximum cutting depth is 2 mm / 0.07 inch. 

 

Note: Due to the characteristics of this knife tool, some restrictions apply to the use of it: 

 It is not suitable for curves with small diameter. 

 It is not suitable for designs containing short lines in combination with sharp angles. 

 

 

  

The RotaCut knife tool is prepared for Decagonal knife blades, ø25 mm / 1 inch. 
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8.16.2 Tool adjustment 

The RotaCut knife tool is adjusted in the same way as the other XP tools regarding rotation angle 

and offset, but tool height in manually adjusted: 

 

 

Tool height 

 

Tool height for RotaCut is manually adjusted 

using the tool height adjustment wizard 
available from the Tool configuration dialog. 

 

Follow the instructions in the dialog. 

 

Table

U M

D

 

 

Be careful, though, not to adjust the cutting 

depth too deep into the cutting underlay (figure 

at left). 

U - cutting underlay 

M - material 

D - X/Y moving direction 

 

For more information about how to run the adjustment wizards, see the Tool Configuration 

chapter (88). 

 

 

8.16.3 How to replace the knife blade 

 

Use the spanner and the hexagonal screw driver 

to remove the knife blade fixing nut. 
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Carefully remove the old knife blade and insert 

the new one. 

 

Ensure the blade is properly seated. 

 

Mount the nut and fix it properly. 

 

Observe the alignment pin in the foot and the 

groove in the tool shaft.  

 

Position the foot onto the tool shaft as shown at 

left. 

 

Push the foot into position. A self-locking 

mechanism ensures the foot is kept in place. 

 

Note: Be careful not to hit the sharp knife. 

 

 

Verify by hand that the foot movement is 

smooth. 

 



User Manual, Kongsberg XP 

 

 160 

 

8.16.4 Tool setup for RotaCut 

 

At left, correct setting of Lag- and Width - 
values are shown. 

Lag = 3.5 mm / 0.14 inch 

Width: 7.0 mm / 0.28 inch 

  

Note: After modifying these values, the input-
file has to be re-opened. 

 

 

Use the lag and width parameters to achieve 
proper corner cutting. 
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8.17  Drill / Pen tool 

 

  

 Drill bits are extremely sharp! 

 

8.17.1 Tool Insert Position 

If included, the Tool Insert Position is permanently mounted on the Z1 - tool position. The holder is 

prepared for a ball point pen or a drill tool. 

  

8.17.2 How to insert / remove a drill / pen tool 

  

Inserting a tool - push down until the tool is 
locked in position. 

To remove a tool - press the release button. 

 

 

Drill motor connector: 

To release, grab the housing and lift straight up. 

To insert, move connector carefully down and 

turn it until it fits. Then just push the connector 
down until it is locked in position. 
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8.18 Drill Tool 

This drill tool is for use in re-board and other paper - based materials. The tool is prepared for drill 

bits 0.5 – 6 mm (0.02 - 0.24 inches). 

 

 

 

8.18.1 How to replace a drill bit 

 

Push the drill bit towards the bottom of the chuck. 

Use the wrench to fix the bit in the chuck.  

 

No additional adjustments are necessary, as the tool 

height is measured automatically. 

 

 

 

8.18.2  Tool adjustment 

For this tool, complete the following adjustments: 

Tool height Measured automatically, possible to add an offset value. 

Tool Offset Adjust offset relative to laser pointer. 

For more information about how to run the adjustment wizards, see the Tool Configuration chapter 

(88). 
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8.19 The Ball point tool 

8.19.1 Description 

  

 

The Ball point pen tool is available for pen drawing. 

Tool pressure is adjustable by a knob on top of the tool. 

 

8.19.2 Tool assembly and pressure adjustment 

 

A - Inner sleeve.  

The ball point pen refill is fixed inside the 
sleeve using a screw.  

Use Allen key, 3 mm. 

 

B - Sleeve holder with spring and pressure 

adjustment knob. 

 

C - pen tool 

 

Adjust tool pressure using the screw s. 

Lock the adjustment screw using the 

locking knob k. 

  

  

8.19.3  Tool adjustment 

For this tool, complete the following adjustments: 

Tool height Measured automatically, possible to add an offset value. 

Center Offset Adjust tool sideways until centered. 

Tool Offset Adjust offset relative to laser pointer. 

For more information about how to run the adjustment wizards, see the Tool Configuration chapter 

(88). 
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8.20 Measuring foot 

  

P1 P2
L

M

 
  

The Measuring foot (M in the illustration) has 3 functions: 

1. Measure the thickness of the material on the table 

2. Map Table Top Surface. 

3. Calibration of the Measuring station. 

No adjustments are necessary. 

 

  

8.21 Laser pointer 

The Laser pointer (L in the illustration) is a Class II laser beam pointing device. 

Wavelength: 650 nm, 1 mW. 

 

The laser pointer is used in adjustment wizards and job execution to indicate current position on the 

table. 

 

The laser pointer is lit as long as it indicates the correct current position. 

If there is no manual operation of the table, the laser pointer will be switched off after a 30 sec. time 

out. Pressing any button on the Operators panel will switch the laser pointer on again. 
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9. Maintenance 

 

 

9.1 General 
 

Warning 

The main power should be switched off before cleaning is carried out. 

 

More detailed information about XP maintenance is available in the Maintenance 

Manual for Kongsberg XP. 

 

 

9.2 Daily maintenance 

Inspect 

 Inspect the equipment in order to prevent any irregularities. 

 

 

Clean 

 The table surface should be kept clean at all times. For cleaning, use iso-propyl alcohol or 

white-spirit. 

 

 The room should be cleaned regularly. Keep the cables free from grease, floor vax etc. 

 

 Use a vacuum cleaner to keep the inside of the conveyor belt clean. 

 

  

 

9.3 Weekly Maintenance  

Guide-ways and bearings 

The guide-ways and the bearings should be thoroughly cleaned and oiled very lightly with Tellus R10 

oil. 

 

 

Photo cells 

The surface of the transmitter and receiver should be carefully cleaned using light soap and clean 

water. 

 

 

Air pressure reduction valve 

The automatic draining action of the air pressure reduction valve should be controlled: 

Switch off the air compressor and allow the air pressure to fall. Switch on the air compressor and 

check that any water in the glass bowl of the pressure reduction valve drains out automatically 

during the first few seconds of operation. Remove and clean the bowl if the automatic draining 

action does not operate or if it appears to be an excessive amount of dust in the bowl. 

 

 

Warning! 
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If the automatic draining action fails water can enter the tool holder assembly resulting in severe 

damage to the tool holder mechanism. 

 

 

9.4 Monthly Maintenance 

Monthly maintenance includes: 

 

9.4.1 Gears 

The gears in X1, X2 and Y should be re-greased using the grease gun: 

 

   

X1 X2 Y 

 

9.4.2 Racks 

The racks in X1, X2 and Y should be re-greased: 

 

 
  

X1 X2 Y 

 

9.4.3 Vacuum table 

Every other month, or after the table surface has been cleaned, the closed vacuum holes in the 

surface should be opened in order to retain the hold-down efficiency. Use a steel pin, 0.5 - 0.6 mm, 

and with the vacuum system switched on, free the vacuum holes by pushing the obstructions down 

into the table. 
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9.5 Maintenance, external equipment 

All external equipment, as PC, Vacuum pump and compressor should be maintained according to the 

User Manual for the actual equipment. 
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10. Fuse replacement 

 

 

Switch power off with the Main Power switch before starting the fuse 

replacement procedure. 

Remove the main power plug from the wall socket as an extra precaution 

before starting the fuse replacement procedure. 

  

 

10.1 MPU fuses 

Fuse location 115V 230V 

Line fuses F1 and F2 T 15A 250V 1 1/4 x 1/4 in 

(6,3 x 32 mm) 

T 6,25A 250V 1 1/4 x 1/4 in 

(6,3 x 32 mm) 

200V Servo power fuse F200 T 15A 250V 1 1/4 x 1/4 in 
(6,3 x 32 mm) 

T 15A 250V 1 1/4 x 1/4 in 
(6,3 x 32 mm) 

48V Servo power fuse F48 T 8A 250V 1 1/4 x 1/4 in 

(6,3 x 32 mm) 

T 8A 250V 1 1/4 x 1/4 in 

(6,3 x 32 mm) 

+24V fuse F4 T 6.25A 250V 1 1/4 x 1/4 in 
(6,3 x 32 mm) 

T 6.25A 250V 1 1/4 x 1/4 in 
(6,3 x 32 mm) 

  

All fuses are located on the rear side of the Main Power Unit (MPU): 

 

F24 F48 F200 F1 F2

Line fuse

P13mp

P4mp

P1mp

P2mp

P5mp

P1
8m

p

P4
8-

2m
p

P200mp

P1
4m

p

P1
9m

p

P4
8m

p

 
 

 

MPU

 

Fuse replacement procedure: 

 

1. Remove base cover in front of MPU 

2. Remove one fuse, check with ohm - meter, if blown, 

replace with a new identical fuse. Repeat for each 

fuse. 

3. Replace base cover 

4. Insert main power cable into the wall socket and turn 

main power ON. 
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10.2 X1 fuse  

  
1 – 8/24A AC amplifier X1 

2 – SCU unit 

F2F3F4F5

J1
D1

J3

11 22 33

J7

  

1. Remove X1 cover. 

2. Remove cover from AC amplifier unit. 

3. Check fuses F2 – F5 with ohm - 

meter. If blown, replace with a new 

identical fuse.  

4. Replace covers. 

5. Insert main power cable into the wall 
socket and turn main power ON. 

Fuse:  T 10A 250V (5 X 20 mm). 
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10.3 X2 fuse  

  
 

F2F3F4F5

J1
D1

J3

11 22 33

J7

   

1. Remove X2 cover. 

2. Remove cover from AC amplifier unit. 

3. Check fuses F2 – F5 with ohm - 

meter. If blown, replace with a new 

identical fuse.  

4. Replace covers. 

5. Insert main power cable into the wall 
socket and turn main power ON. 

Fuse:   

T 10A 250V (5 X 20 mm). 
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10.4 Y fuse  

   
 

1 – Y-motor with encoder. 

2 – TCU. 

3 – AC amplifier for Y. 

4 – Z1 – motor. 

5 – Z2 – motor 

 

F2F3F4F5

J1
D1

J3

11 22 33

J7

   
 

1. Remove Y cover. 

2. Remove cover from AC 

amplifier unit. 

3. Check fuses F2 – F5 with 

ohm - meter. If blown, 

replace with a new identical 

fuse.  

4. Replace covers. 

5. Insert main power cable 

into the wall socket and 

turn main power ON. 

Fuse:   

T 10A 250V (5 X 20 mm). 

  



User Manual, Kongsberg XP 

 

 172 

10.5 Z1 / Z2 fuses 

   
 

1 – Y-motor with encoder. 

2 – TCU. 

3 – AC amplifier for Y. 

4 – Z1 – motor. 

5 – Z2 – motor 

 

 
 

1. Remove Y cover. 

2. On the TCU – unit, check 

fuses Fz1 and Fz2 with ohm 

- meter. If blown, replace 

with a new identical fuse.  

3. Replace covers. 

4. Insert main power cable 

into the wall socket and 
turn main power ON. 

Fuse:  T 4A 250V 1 1/4 x 1/4 

in (6,3 x 32 mm). 
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10.6 Fuses: Tool rotation / Reciprocating knife  

 

1. Fuses are available on the Tool Board 

inside the actual tool. 

2. Remove the plastic cover on the tool. 

3. Remove fuse Fhr or Fu/d, check with ohm 

- meter. If blown, replace with a new 

identical fuse.  

4. Insert main power cable into the wall 
socket and turn main power ON 

For information about fuse sizes, see table 

below. 

  

  

 

(Esko part number) 

 

Drill tool Drill FDr 2 T 2A 125V NANO (42441618) 

Hi-force knife tool Tool rotation Fhr 2 T 2A 125V NANO (42441618) 

Hi-Freq VibraCut knife tool Tool rotation Fhr 2 T 2A 125V NANO (42441618) 

Hi-Freq VibraCut knife tool Vib. Fu/d 4 T 4A 125V NANO (42444828) 

Presscut knife tool Tool rotation Fhr 2 T 2A 125V NANO (42441618) 

Presscut knife tool Tool u/d Fu/d 0.75 T 0,75A 125V NANO (42442541) 

RM knife tool Tool rotation Fhr 4 T 4A 125V NANO (42444828) 

RotaCut Knife RPM  2 T 2A 125V NANO (42441618) 

VariCut knife tool Tool rotation Fhr 2 T 2A 125V NANO (42441618) 

VariCut knife tool Knife depth Fu/d 0.5 T 0,5A 125V NANO (42441600) 

VibraCut knife tool Tool rotation Fhr 2 T 2A 125V NANO (42441618) 

VibraCut knife tool Vib. Fu/d 2 T 2A 125V NANO (42441618) 

HDU Tool rotation Fhr 4 T 4A 125V NANO (42444828) 
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10.7  HPMU Chiller fuse 

 

 

Remove the on/off button Remove cover (4 screws) 

 

 

Fuse location Pull out the fuse holder 

  

Turn the fuse holder 90 deg. Now you have easy access to the fuse. 

1 - Spare fuse 

2 - Fuse in action 

Fuse: T 1A 250V (5x20 mm) 
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10.8 HPMU Chiller heater fuse 

 

F= 

4A 250V T 5x20mm Slow Blow (42448944) 
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11. Appendices, introduction 

 

The appendices section of this manual contains mainly reference information.  

Much of this is available also in the context-sensitive help included in XP-Guide. 

 

For that reason, you will find this section in English language only. 

 

 



User Manual, Kongsberg XP 

 

 177 

12. Appendix - The Graphical User Interface 

 

 
 

The XP Graphical User Interface (GUI) contains these main elements: 

 

1 Main Menu 5 Preview 

2 Main Toolbar 6 Job View Toolbar 

3 File View Toolbar 7 Job View  

4 File View 8 ARS Toolbar 

 9 Status Bar 
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12.1 The Main Menu 

 

 
 

The following functions are available from Main Menu and sub-menus: 

 

12.1.1 File 

Open Open an Input File (66). 

Create a box Work with 123Box (59). 

Exit Terminate XP-Guide. 

 

 

12.1.2 View 

Position Display Display of table positions and parameters (189). 

View Messages Message Display; provides a log of system messages (188). 

Customize File View File View configuration (181). 

View Finished Jobs List finished jobs when running in Auto Open mode (183). 

Tool bars Configure GUI tool bars 

Status Bar Configure Status Bar (187). 

 

 

12.1.3 Options 

Tool configuration Tool configuration and adjustments (88). 

Job Setup Select and edit job setup files (78). 

Board Size setup Edit table of available board sizes (95). 

Toggle Flute Direction Specify actual flute/grain direction to the system (95). 

Transformation Specify scale and rotation (96). 

Step and Repeat Specify multiple copies of current job (98). 

Counter setup  Parameter setting for crease using a matrix (99).  
(For folding carton only). 

System Option Enter the System Option dialog (74). 

Table Options Enter the Table setup dialog (71). 

Registration setup Configure the ARS system (103). 
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12.1.4 Layout 

Toggle Layout Mode Toggles between single and multi design layout (85). 

Layout setup Job layout configuration (85). 

Delete Delete selected design (85). 

Delete All Delete all designs (85). 

Select All Select all designs (85). 

Rotate 90 Rotates selected design 90 degrees (85). 

Rotate 180 Rotates selected design 180 degrees (85). 

Rotate. Rotates selected design a user defined angle (85). 

 

 

12.1.5 Help 

About XP-Guide XP-Guide version information.  

 

Information about maintenance intervals. You will find more information 
about this issue in the Technical Manual for XP. 

User Manual A link to this document. 
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12.2 The Main Toolbar functions 

 

 
 

The left part of the Main Toolbar contains the following general functions:  

 

 
 

 
Selects application from the drop down list. 

 
View the Message Display (188). 

 
Enter Tool Configuration (88). 

 
Set Single Design operation (85). 

 
Set Multi Design operation (85). 

 
Work with 123Box (59). 

 
Start HSMU/HPMU spindle warm up (HSMU/HPMU only). 

 
Start vacuum cleaner (HSMU/HPMU only). 

 
Enter the Help system. 

  

The right part contains the following functions: 

 

 
 

 

Shows measured thickness of material on the 

table. 

 
Rewinds current job. 

 

T:  Estimated total job time. 
R:  Estimated remaining job time. 
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12.2.1 Main Toolbar configuration 

From View->Toolbars, you can configure the Main toolbar to show left / right / none of the Main 

toolbar. 

 

 

12.3 File View 

 
 

 

 
 

A total of 5 columns can be displayed in the File View. 

The file name is always displayed in column 1. 

The other 4 columns can be customized in the Customize File View dialog. 

 

The files in the File View are sorted in normal or reversed order. The sorting is toggled by clicking 

the header of the columns. 

 

The files are ranged the way they will be executed when Auto Open is activated. 

 

A single click on a file will display the design in the Preview window. 

When a file is opened, that is selected as a job; the design will be displayed in Job View. 

 

12.3.1 Customize File View 

 

The Customize File View – dialog is available from: 

 

 Main Menu->View->Customize File View 

 File View->Pop-up menu 
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Use the Customize File View dialog to define the kind of data which you want displayed in the 

columns in File View. 

 

Customize the 4 columns by selecting the appropriate field in the drop down list. 

 

The content of the different fields are File Header - parameters in the Input File, except from the 

Size, which is calculated after the file has been opened. 
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12.4 File View toolbar 

 
 

You will find the following buttons in the File View toolbar: 

 

 
 

 

 
Opens selected file. 

 
Selects disk drive for input files. 

 
Up one level. 

 
Shows file names only. 

 
Shows file names and details. 

 

 

12.4.1 Auto Open function 

 

Enable „Move finished file‟ – mode. 

Moves the current job, when finished, to a sub-directory and removes it from the list of 
files in the File View. 

Press the button a second time to disable the „Move finished file‟ – mode. 

Note: You can view finished job by selecting View->View Finished Jobs on the menu or 
by selecting View finished job from the pop-up menu in the file view. 

 

Auto Open function 

Pressing this button activates the Auto Open function. The file at the top of the File View 

list will automatically be opened as a new job when the current job is finished. 

Press the button a second time to disable the „Auto Open‟ – function. 

Note: It is a pre-requisite for this function that the „Move finished file‟ – mode is enabled. 

 

When the „Move finished file‟ – button shows this face, it indicates that the „Move finished 
file‟ – mode is disabled – no automation. 

 

 

 

  

  



User Manual, Kongsberg XP 

 

 184 

12.5 The Job View 

 
 

 

 
 

When you open a file, the design is displayed in the Job View window.  

 

Designs placed in Job View can be manipulated according to the selected layout mode. 

 

Various display options are available from the Job View toolbar. 

 

The File Information Bar on top of Job View display some parameters regarding the last Input 

File opened.  

 

   



User Manual, Kongsberg XP 

 

 185 

12.6 Job View toolbar 

 
 

 

 
 

 

 

Show job view in full screen.  

When in full screen display, the button face changes to this: 

 
Show job view in split screen. 

 

Enters zoom mode. The cursor changes to a magnifying glass. Select area to 

be zoomed. 

 
View design only. 

 
View design and selected board size. 

 
View design, selected board size and the table size. 

 
Enters the Job Setup dialog. 

 

Enter ARS registration setup dialog. 

XP-Guide is running with ARS enabled 

 

Enter ARS registration setup dialog. 

No ARS functions are enabled 

 
Rotate direction of flute (corrugated) or grain (folding carton). 

 
Rotate direction of flute (corrugated) or grain (folding carton). 

 
Automatic Register System (ARS). 
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Register to sheet edge. Enables XL-register functions. The select reference 

functions are disabled. 

 
Select Reference Point from the drop down list. 

 
Selects a Job Setup file from the drop down list. 

 
Selects Board Size from the drop down list. 

 
Enter the Step and Repeat setup dialog. 

 
Number of copies for the Step and Repeat function. 

 

Enters the Matrix function. 

( Matrix function is for Folded Carton application only ) 

 
Button face when the Matrix function is enabled. 

 
Vacuum section selection 

 
Indicates that all designs are inside the working area. 

 
Indicates that one ore more designs are outside the working area. 

 
Displays the mouse pointer position relative to the selected Reference Point. 

 

 

 

12.7 Preview 

 
 

A single click on a file in File View will display the job in the Preview window. 
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12.8 Status bar 

 
 

The status bar at the bottom of the GUI shows brief descriptions of various functions in the GUI. 

The status bar can be toggled on and off from Main Menu->View->Status bar. 

 

 

 

12.9 Critical Warning Display 

When a situation that requires an action from the operator occurs in the system, the following 

message box will be displayed: 

 

 
 

Additional information may be achieved in the Message Display: 
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12.10 Message Display 

  
 The Message Display is available from the Main Toolbar button. 

 

 

 
 

The Message display offers additional information when troubleshooting the system. 

Normally you will get all the necessary information from the pop-up Critical Warning Display.  

 

For additional information, please examine the Message Display. 

 

 

Pop-up on warnings 

Check this box if you want warnings to be automatically displayed. 

 

 

Always on top 

Check this box if you want the Message display to stay on top. 

 

 

Log messages 

The system is prepared for output of additional system information, useful for service and 

troubleshooting. For normal operation disable this function to reduce the amount of messages. 

 

 

Show: 

The type of information displayed in the Message display can be configured to: 

1. Critical messages only 

2. Critical and important messages 
3. All messages. 
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12.11 Position Display 

The Position Display is available from: 
 Main Menu->View->Position display 

 Ctrl + D 

 

Use the set of radio-buttons to select one of the available displays:  

 

12.11.1 Program reference 

 
 

Displays table coordinates relative to program reference point 

 

12.11.2 Table reference 

 
 

Displays table coordinates relative to table reference point 
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12.11.3 Tool Rotation and Z - axes 

 
 

Display Z and Tool Rotation positions. 

 Z shows actual distance from Z axis zero position 

 Tool Rotation shows actual angle from Tool Rotation zero 

 Material thickness shows measured thickness of material on the table 

  

12.11.4 Encoder count, X and Y 

 
 

Shows encoder input as read for X1, X2 and Y encoders 

 

12.11.5 Encoder count, Z and Tool Rotation 

 
 

Shows encoder input as read for Z and Tool rotation encoders 
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12.12  Accelerator Keys 

Key Function 

Ctrl + B Board Size setup 

Ctrl + D Position Display 

Ctrl + F Toggle Flute Direction 

Ctrl + J Edit Job Setup 

Ctrl + O Open Input File 

Ctrl + P Set ball point pen pressure (N/A) 

Ctrl + S Step And Repeat setup 

Ctrl + T Tool Configuration 

    

F1 Help in active window 

    

Ctrl + Alt + D Memory dump 

Ctrl + Alt + L Servo Log 

Ctrl + Alt + O System Setup 

Ctrl + E Display axis force 

Ctrl + Alt + K Keyboard command entry 

 

 



User Manual, Kongsberg XP 

 

 192 

13. Appendix - Install software 

   

13.1  Install XP-Guide system software 

A detailed description of the installation of XP-Guide is found in the installation manual 

3090_InstallationMan_xp_us available on the XP-Guide CD. 

 

 

13.2 Install ARS software 

For the ARS option to work properly, a Scorpion sw installation has to be completed. You will find a 

detailed description in the service guide for XP, 3115_ServiceGuide_XP_ARS.pdf, available on the 

XP-Guide CD. 
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14.  Appendix - CAD-X preview dialog 

 

 
 

This dialog is used when importing DXF, CFF2 or DDES files and when opening ArtiosCAD designs 

(.ARD). 

The dialog shows the design as read by CAD-X.  

At the lower left there is a field showing operator messages. 

 

 

14.1 Board code 

 

Display the selected board code. Board code is a code used in the 
actual factory to identify the boards available. 

 

 

14.2 Size 

 

Display the size of the design (X x Y) in selected units, mm or inch. 

 



User Manual, Kongsberg XP 

 

 194 

 

14.3 Zoom functions 

 

Zoom rectangle. Push the button. Use the mouse to select the preview area you want to 
see in the window. 

 
Zoom out. Push the button to expand the view. 

 
Scale to fit. Preview is scaled to fit the window. 

 

 

14.4 Flute button  

Display the flute or grain direction. Direction may be altered by pushing the button. 

 

 
Flute/Grain is along X. 

 
Flute/Grain is along Y. 

 

 

14.5 Design side display 

Show which side of a design that is displayed.  

 

 
Inside 

 
Outside 

 

14.6 Unit display  

Show the units used for the preview display.  

 

 
Inches 

 
mm 
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14.7 Produce box  

  

Press the Produce Box button to create the cutting file and transfer it to 
XP-Guide. 

Before the CAD-X preview dialog is closed, you are asked to save current 

design:  

 

The recommended directory for design storage 

is: 

C:\esko\artios\designs. 

 

Give the design a name and press Save.  

 

After this, XP-Guide is displayed with the 

selected design displayed in Job view, ready to 

be cut. 

 

 

14.8 Job setup  

 

Job setup is opened for editing. 

For more information about Job setup, see XP-Guide Online Help. 

 

 

14.9 Save design  

 

Save current design (.ard). 

The recommended directory for design storage is: C:\esko\artios\designs. 

 

 

14.10 Open design  

 

Open another design (.ard). Same as double-clicking an ard-file in XP-Guide File 

View. 
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14.11 Show all layers  

  

Show all layers in a design. Inside ArtiosCAD, a design is separated into layers. One 

layer contains the geometry; one layer contains all dimensions and so on.   
Use this option to verify your settings. 

 

14.12 Create a new box  

 

Start from the beginning, select and specify a new box. 

 

 

14.13 Resize Box  

 

Enter dialog for modification of box parameters. 

 

 

14.14 Exit  

Close this dialog. 
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15. Appendix – Roll feeder 

 

 

A

D E

B

C

 

A – Bracket position pin (push the center button to release the lock). 

B – Roll holder bracket. 

C – Brake position locker. 

D – Roller brake. 

E – Brake tension adjustment. Turn clockwise to increase tension. 

 

 

To adapt to different roll sizes, three roll holder 

positions are prepared. 

 

To move the roller bracket, remove pin (A) and 

release locker (C). 

 

To disengage the roller brake, release the brake 

position locker (C) and tilt the bracket. 
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16. Appendix – Zefiro 75, vacuum cleaner 

 

16.1 Introduction 

1

3

2

 

1 – Filter chamber 

2 – Filter shaking lever 

3 – Removable material container 

 

Note: 

Carefully observe the vacuum cleaner filling level. 

If the vacuum cleaner container is filled up completely, the dust 

removal function will stop with a high risk for HSMU/HPMU motor 

damage. 

 

 

 

16.2 Filter shaking 

 

Filter shaking is important in order to maintain a 
good vacuum cleaner performance. 

Filter shaking is best operated every time before 

use and after prolonged operation. 

 

Note: This operation must be performed only 

when the vacuum cleaner is switched off and the 
motor has stopped. 
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16.3 Remove material container 

  

> >> 

 

Note:  

You can use the container with or without plastic 

bags. 

 

 

 



User Manual, Kongsberg XP 

 

 200 

16.4 Use plastic bag in material container  

  

Parts needed: Steel ring and plastic bag Fix the plastic bag to the ring in this way 

  

Ring and plastic bag ready for the container Fold/fix the plastic bag around the container 

 

 

 

Container with plastic bag ready for operation  

 

Detailed information about how to operate the vacuum cleaner is available in the Zefiro 75 

Operators and maintenance manual. 

 

  

  

 

 


